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Flash Fill option 

 

 

Using Flash Fill in Excel 

Flash Fill automatically fills your data when it senses a pattern. For example, you can use Flash 

Fill to separate first and last names from a single column, or combine first and last names from 

two different columns. 

Note: Flash Fill is only available in Excel 2013 and later. 

How to use Flash Fill in Excel  

Flash Fill is one of the most amazing features of Excel. It grabs a tedious task that would take 

hours to be performed manually and executes it automatically in a flash (hence the name). And it 

does so quickly and simply without you having to do a thing, but only provide an example of 

what you want. 

What is Flash Fill in Excel? 

Excel Flash Fill is a special tool that analyses the information you are entering and automatically 

fills data when it identifies a pattern. 

The Flash Fill feature was introduced in Excel 2013 and is available in all later versions of Excel 

2016, Excel 2019, Excel 2021, and Excel for Microsoft 365. 

History 

Started in December 2009 as an attempt of Sumit Gulwani, a senior researcher at Microsoft, to 

help a businesswoman he accidentally met at the airport with her merging challenge, a few years 

later it has evolved into a powerful ability to automate many Excel chores. 

Flash Fill easily copes with dozens of different tasks that otherwise would require complex 

formulas or even VBA code such as splitting and combining text strings, cleaning data and 

correcting inconsistencies, formatting text and numbers, converting dates to the desired format, 

and a lot more. 

Each time, Flash Fill combines millions of small programs that might accomplish the task, then 

sorts those code snippets using machine-learning techniques and finds the one that suits best for 

https://www.microsoft.com/en-us/research/blog/flash-fill-gives-excel-smart-charge/


the job. All this is done in milliseconds in the background, and the user sees the results almost 

immediately! 

Where is Flash Fill in Excel? 

In Excel 2013 and later, the Flash Fill tool resides on the Data tab, in the Data tools group: 

 

 

 

Excel Flash Fill 

shortcut 

Those of you who prefer working from a keyboard most of the time, can run Flash Fill with this 

key combination: Ctrl + E 

How to use Flash Fill in Excel 

Usually Flash Fill starts automatically, and you only need to provide a pattern. Here's how: 

1. Insert a new column adjacent to the column with your source data. 

2. In the first cell of a newly added column, type the desired value. 

3. Start typing in the next cell, and if Excel senses a pattern, it will show a preview of data to be 

auto-filled in the below cells. 

4. Press the Enter key to accept the preview. Done! 

5.  

 

 

 

 

 

How to Flash Fill in Excel with a button click or 

shortcut 

In most situations, Flash Fill kicks in automatically as soon as Excel establishes a pattern in the 

data you are entering. If a preview does not show up, you can activate Flash Fill manually in this 

way: 

1. Fill in the first cell and press Enter. 

2. Click the Flash Fill button on the Data tab or press the Ctrl + E shortcut. 

Tips: 

• If you are unhappy with the Flash Fill results, 

you can undo them by pressing Ctrl + Z or 

via the Flash Fill options menu. 

• If Flash Fill does not start automatically, try 

these simple troubleshooting techniques. 

• To find the number of the Flash Fill changed 

cells, just look at the Excel status bar. 

https://www.ablebits.com/office-addins-blog/flash-fill-excel-examples/#flash-fill-options
https://www.ablebits.com/office-addins-blog/flash-fill-excel-examples/#Excel-flash-fill-not-working
https://www.ablebits.com/office-addins-blog/status-bar-excel/#flash-fill-changed-cells


 

 

 

 

 

Excel Flash Fill options 

When using Flash Fill in Excel to automate data 

entry, the Flash Fill Options button appears 

near the auto- filled cells. Clicking this 

button opens the menu that lets you do the 

following: 

• Undo the Flash Fill results. 

• Select blank cells that Excel has failed to populate. 

• Select the changed cells, for example, to format them all at once. 

 

Excel Flash Fill examples 

As already mentioned, Flash Fill is a very versatile tool. The below examples demonstrate some 

of its capabilities, but there is much more to it! 

Extract text from cell (split columns) 

Before Flash Fill came into existence, splitting the contents of one cell into several cells required 

the use of the Text to Columns feature or Excel Text functions. With Flash Fill, you can get the 

results instantly without intricate text manipulations. 

Supposing you have a column of addresses and you want to extract zip codes into a separate 

column. Indicate your goal by typing the zip code in the first cell. As soon as Excel understands 

what you are trying to do, it fills in all the rows below the example with the extracted zip codes. 

You only need to hit Enter to accept them all. 

 

 

https://www.ablebits.com/office-addins-blog/split-text-string-excel/
https://www.ablebits.com/office-addins-blog/excel-substring-functions-extract-text/


 

 

 

Formulas to split cells and extract text: 

• Extract substring - formulas to extract text of a specific length or get a substring before or after a 

given character. 

• Extract number from string - formulas to extract numbers from alphanumeric strings. 

• Split names in Excel - formulas to extract first, last and middle names. 

Extracting and splitting tools: 

• Split Text - a versatile tool to divide cell content into multiple columns or rows. Easily split 

string by any character, string, or mask. 

• Split Names tool - fast and easy way to separate names in Excel. 

Combine data from several cells (merge columns) 

If you have an opposite task to perform, no problem, Flash Fill can concatenate cells too. 

Moreover, it can separate the combined values with a space, comma, semicolon or any other 

character - you just need to show Excel the required punctuation in the first cell: 

 

 

Formulas to join cell values: 

• CONCATENATE function in Excel - formulas to combine text strings, cells and columns. 

Merging tools: 

• Merge Tables Wizard - quick way to combine two tables by common columns. 

• Merge Duplicates Wizard - Combine similar rows into one by key columns. 

Clean data 

If some data entries in your worksheet begin with a leading space, Flash Fill can get rid of them 

in a blink. Type the first value without a preceding space, and all extra spaces in other cells are 

gone too: 

 

https://www.ablebits.com/office-addins-blog/excel-substring-functions-extract-text/
https://www.ablebits.com/office-addins-blog/excel-extract-number-from-string/
https://www.ablebits.com/office-addins-blog/separate-first-last-name-excel/#split-names-Excel-formulas
https://www.ablebits.com/excel-suite/split-text-to-colums.php?visitfrom=blog-text
https://www.ablebits.com/excel-split-names/index.php
https://www.ablebits.com/office-addins-blog/excel-concatenate-strings-cells-columns/
https://www.ablebits.com/excel-lookup-tables/index.php
https://www.ablebits.com/excel-combine-rows/index.php


Formulas to clean data: 

• Excel TRIM function - formulas to remove excess spaces in Excel. 

Data cleaning tools: 

• Trim Spaces - trim all leading, trailing and in-between spaces but a single space character 

between words. 

Format text, numbers and dates 

Quite often the data in your spread sheets is formatted in one way while you want it in another. 

Just start typing the values exactly as you want them to appear, and Flash Fill will do the rest. 

Perhaps you have a column of first and last names in lowercase. You wish the last and first 

names to be in proper case, separated with a comma. A piece of cake for Flash Fill : 

 

 
Maybe you are working with a column of numbers that need to be formatted as phone numbers. 

The task can be accomplished by using a predefined Special format or creating a custom number 

format. Or you can do it an easy way with Flash Fill: 

 

To re-format the dates to your liking, you can apply the corresponding Date format or type a 

properly formatted date into the first cell. Oops, no suggestions have appeared… What if we 

press the Flash Fill shortcut (Ctrl + E) or click its button on the ribbon? Yep, it works 

beautifully! 

 

https://www.ablebits.com/office-addins-blog/excel-trim-function/
https://www.ablebits.com/excel-suite/trim-spaces.php?visitfrom=blog-text
https://www.ablebits.com/office-addins-blog/excel-format-number-text/#Special-format
https://www.ablebits.com/office-addins-blog/custom-excel-number-format/
https://www.ablebits.com/office-addins-blog/custom-excel-number-format/
https://www.ablebits.com/office-addins-blog/change-date-format-excel/#change-date-format


Replace part of cell contents 

Replacing part of a string with some other text is a very common operation in Excel, which Flash 

Fill can also automate. 

Let's say, you have a column of social security numbers and you want to censor this sensitive 

information by replacing the last 4 digits with XXXX. 

To have it done, either use the REPLACE function or type the desired value in the first cell and 

let Flash Fill auto fill the remaining cells: 

 

Advanced combinations 

Flash Fill in Excel can accomplish not only straightforward tasks like demonstrated in the above 

examples but also perform more sophisticated data re-arrangements. 

As an example, let's combine different pieces of information from 3 columns and add a few 

custom characters to the result. 

Supposing, you have first names in column A, last names in column B, and domain names in 

column C. Based on this information, you want to generate email addresses in this 

format: initial.surname@domain.com. 

For experienced Excel users, there is no problem to extract the initial with the LEFT function, 

convert all the characters to lowercase with the LOWER function and concatenate all the pieces 

by using the concatenation operator: 

=LOWER(LEFT(B2,1))&"."&LOWER(A2)&"@"&LOWER(C2)&".com" 

 

But can Excel Flash Fill create these email addresses for us automatically? Sure thing! 

https://www.ablebits.com/office-addins-blog/excel-replace-substitute-functions/#Excel-REPLACE-function
https://www.ablebits.com/office-addins-blog/excel-left-function/
https://www.ablebits.com/office-addins-blog/excel-concatenate-strings-cells-columns/#concatenation-operator


 

Excel Flash Fill limitations and caveats 

Flash Fill is an awesome tool, but it does have a couple of limitations that you should be aware 

of before you start using this feature on your real data sets. 

1. Flash Fill results do not update automatically 

Unlike formulas, the results of Flash Fill are static. If you make any changes to the original data, 

they won't be reflected in the Flash Fill results. 

2. May fail to identify a pattern 

In some situations, especially when your original data are arranged or formatted differently, 

Flash Fill may stumble and produce incorrect results. 

For example, if you use Flash Fill to extract middle names from the list where some entries 

contain only the First and Last names, the results for those cells will be wrong. So, it is wise to 

always review the Flash Fill output. 

 

3. Ignores cells with non-printable characters 

If some of the cells to be auto-filled contain spaces or other non-printable characters, Flash Fill 

will skip such cells. 

 

So, if any of the resulting cells are blank, clear those cells (Home tab >Formats group 

> Clear > Clear All) and run Flash Fill again. 



4. May convert numbers to strings 

When using Flash Fill for reformatting numbers, please be aware that it may convert your 

numbers to alphanumeric strings. If you prefer to keep the numbers, use the capabilities of Excel 

format that changes only the visual representation, but not the underlying values. 

 

How to turn Flash Fill on and off 

Flash Fill in Excel is turned on by default. If you do not want any suggestions or automatic 

changes in your worksheets, you can disable Flash Fill in this way: 

1. In your Excel, go to File> Options. 

2. On the left panel, click Advanced. 

3. Under Editing options, clear the Automatically Flash Fill box. 

4. Click OK to save the changes.  

 

  

https://www.ablebits.com/office-addins-blog/excel-format-number-text/
https://www.ablebits.com/office-addins-blog/excel-format-number-text/


To re-enable Flash Fill, simply select this box again. 

Excel Flash Fill not working 

In most cases, Flash Fill works without a hitch. When it falters, the below error may show up, 

and the following tips will help you get it fixed. 

 

1. Provide more examples 

Flash Fill learns by example. If it is unable to recognize a pattern in your data, fill in a couple 

more cells manually, so that Excel could try out different patterns and find the one best suited for 

your needs. 

2. Force it to run 

If Flash Fill suggestions do not appear automatically as you type, try to run it manually. 

3. Make sure Flash Fill is enabled 

If it does not start either automatically or manually, check if the Flash Fill functionality is turned 

on in your Excel. 

4. Flash Fill error persists 

If none of the above suggestions has worked and Excel Flash Fill still throws an error, there is 

nothing else you can do but enter the data manually or with formulas. 

That's how you use Flash Fill in Excel. I thank you for reading and hope to see you on our blog 

next week! 

--x---x---x-- 

 

 

  

https://www.ablebits.com/office-addins-blog/flash-fill-excel-examples/#flash-fill-button
https://www.ablebits.com/office-addins-blog/flash-fill-excel-examples/#enable-disable-flash-fill
https://www.ablebits.com/office-addins-blog/flash-fill-excel-examples/#enable-disable-flash-fill


Database access from MS Excel 

 

“Microsoft Access is an excellent general-purpose database management system whereas 

Excel is a spread sheet package, with lots of extra features thrown in.” 

MS Excel vs Access Comparison 

MS Excel and Access are both Microsoft Office products. Microsoft Access, from the Office 

suite, is an excellent general-purpose database management system made for storing and 

analysing data. 

Excel on the other hand is a spread sheet package, with lots of extra features thrown in which 

allow you to do things like creating pivot tables for summarising data. Using Excel as a 

database is great for small businesses and database beginners. 

What Is MS Excel Used For? 

Many people use Excel in business for a range of tasks from simple admin to full-scale 

automation. Thanks to its easy to use features Excel is very flexible and allows you to summarise 

data quickly without having to do anything too complicated. 

Some of the uses for Excel include: 

• Tabulating and analysing complex numerical data 

• Creating tables and forms 

• Writing and running macros to automate tasks 

• General day-to-day data management (e.g., creating reports, charts, etc.) 

• Store and manipulate audio and video files 

Excel is very intuitive and easy to use, which allows most people to learn it quickly. If you’re job 

hunting, including Excel skills on your CV can help you out a lot! 

What Is An MS Access Database Used For? 

MS Access is a database management system that gives you the ability to store your data in a 

relational database. This means that you can have multiple tables, linked together to form a 

relationship, which is all stored in one file. 

The advantage of this is that if you update data in one table, it automatically updates all related 

records. This eliminates a lot of time-consuming admin and manual errors. 

https://amzn.to/40HY96G
https://www.theexcelexperts.com/using-excel-as-a-database/
https://www.theexcelexperts.com/using-excel-as-a-database/
https://www.theexcelexperts.com/importance-excel-business/
https://www.theexcelexperts.com/excel-microsoft-office-skills-cv/
https://amzn.to/40HY96G


Access is great for 

• Storing and managing large amounts of data 

• Running reports that allow for grouping and sorting data 

• Managing relational databases (e.g., adding and deleting tables, etc.) 

The main disadvantage of Access is that it can be quite confusing to set up a database the first 

time. This means you should work with an MS Access Expert to help set it up and ensure 

everything is running smoothly. 

“Excel and Access share some traits but are ultimately different tools. Comparing them is a 

useful way to highlight the key differences and understand where the strengths and weaknesses 

are.” 

 

Key Differences between Excel vs. Access 

Excel and Access share some traits but are ultimately different tools. Comparing Excel vs. 

Access is a useful way to highlight the key differences between them and understand where the 

strengths and weaknesses are for both products. 

 

 

Excel Do’s and Don’ts: How to Make Your Spread sheets shine! 

Enrol Now! 

Excel vs. Access – Data Visualisation 

Excel allows you to add graphics such as charts, pictures, etc. to your worksheets. You can also 

link these pictures or graphics to your data so they automatically update when the data updates. 

This is great if you have a report that requires data to be displayed in the form of a chart. 

Access allows you to add custom forms when creating a database. These forms can take multiple 

pieces of information from a user and display them in an organised fashion, so they are easy to 

read and navigate. 

https://amzn.to/40HY96G
https://amzn.to/40HY96G
https://click.linksynergy.com/link?id=EJwqZBxBmNA&offerid=1060092.4189886&type=2&murl=https%3A%2F%2Fwww.udemy.com%2Fcourse%2Fbest-practice-for-excel-spreadsheets%2F
https://www.theexcelexperts.com/excel-dashboards-charts-and-graphs/
https://www.theexcelexperts.com/spreadsheet-vs-database/
https://click.linksynergy.com/link?id=EJwqZBxBmNA&offerid=1060092.4189886&type=2&murl=https://www.udemy.com/course/best-practice-for-excel-spreadsheets/


You can also add buttons or links on these forms so your users can navigate to the information 

they require. This is useful if you need your users to provide data on a form or screen that they 

must print and sign, etc. 

Excel vs. Access – Automation 

Excel allows you to add macros so you can automate Excel tasks such as deleting reports once 

they have been printed and saving files on a regular basis. These are useful if your company 

requires the same routine tasks to be performed on various data files on a regular basis. 

On the other hand, Microsoft Access allows you to create modules in which you can write VBA 

(Visual Basic for Applications) code. This allows you to automate certain tasks, such as inserting 

new records into a table or deleting old records. This is great if your company needs a certain set 

of tasks to be completed on a regular basis. 

Excel vs. Access – Data Security 

Excel does not allow you to add security measures to your files, so anyone with access will be 

able to view or edit the data. You can lock or protect individual worksheets with user-level 

security features, which might be useful if you need to restrict access to certain worksheets. 

Access allows you to control who has access to your database files and what they can do with 

them. You can create usernames for multiple users so different people have different levels of 

access, depending on which username they use. 

This is great if you want some users (e.g. managers) to update data, while others (e.g. MS Access 

consultants) are only allowed to view the data and access data when needed. 

Excel vs. Access – Data Analysis 

Excel allows you to perform basic data analysis by adding formulas and performing certain 

functions on written values. 

Access has specific tools that are designed for analysing and summarising your data. These 

include PivotTables, which allow you to create tables that summarise the data in various ways 

(e.g., number of sales per region, etc.). This is great if you want to quickly analyse large amounts 

of data. 

“Because Access is a professional database programme, it has some significant benefits over 

Microsoft Excel when building and using databases. Here are five reasons to use Access vs. 

Excel.” 

 

5 Reasons to Use Microsoft Access vs. Excel 

Because Access is a professional database programme, it has some significant benefits over 

Microsoft Excel when building and using databases. Here are five reasons to use Access vs. 

Excel. 

https://www.theexcelexperts.com/automation/
https://www.theexcelexperts.com/supercharge-excel-vba/
https://www.theexcelexperts.com/supercharge-excel-vba/
https://www.theexcelexperts.com/how-to-lock-cells-in-excel/
https://www.theexcelexperts.com/guide-microsoft-excel-formulas/
https://amzn.to/40HY96G


1. User Security Model 

Access provides all the tools needed to set access permissions on objects such as tables and 

queries. The security model allows you to grant or deny certain users (e.g., managers) rights to 

edit or update data while restricting other users (e.g., consultants) so they are only allowed to 

view data in pre-defined ways. 

2. Data Storage Capacity 

Access is superior to Excel when it comes to the amount of data you can store in a database. This 

is because Access is specifically designed for storing large amounts of data, whereas Excel was 

not. 

3. Maintaining Data Integrity 

Access allows you to define field types and limits, which enforces appropriate data entry and 

prevents users from unintentionally inserting invalid values into fields. 

For example, if your database requires a specific data format, Access can enforce this by 

defining the field as a Date type and setting an appropriate limit (e.g., only valid dates). The 

same applies to numerical values, currency types or text containing specific characters. 

4. Data Analysis 

Access provides various tools that are specifically designed for performing data analysis on large 

data sets. Use Pivot Tables to create tables summarising the data in multiple ways quickly (e.g., 

number of sales per region). This way, you don’t have to enter all the data manually to find the 

information you need. 

5. Summarising Data 

Visual Basic for Applications (VBA) allows you to write code to execute specific tasks 

regularly. This makes it very easy to bring your database up-to-date by adding new records or 

deleting old ones. The VBA capability allows you access to the tables and fields within your 

database, which means that you can automate tasks like importing new records and exporting 

data to other applications. 

“While Access is better suited to being used as a database, Excel can still be helpful too.” 

 

5 Examples Where an Excel Database Is Useful 

While Access is better suited to being used as a database, Excel can still be helpful too. Here are 

three examples where an Excel database might be a good idea: 

https://www.theexcelexperts.com/using-excel-as-a-database/
https://www.theexcelexperts.com/using-excel-as-a-database/
https://amzn.to/40HY96G
https://www.theexcelexperts.com/training/
https://www.theexcelexperts.com/excel-programmers/
https://amzn.to/40HY96G


1. Phone Book 

If you have a small phone book, using Microsoft Excel may be sufficient to store contact details. 

However, if you have a larger phone book, you could create a copy of the contacts in Excel 

and convert this into a database to make it easier to sort, update and retrieve information. In this 

case, you can utilise the standard functionality in Excel to create and manage your contacts. 

2. Product Information Management (PIM) 

Microsoft Excel’s ability to create and update records makes it very useful for storing PIM data. 

The spread sheet can be set up with one column per product and another column for the price. 

One of the most important fields is probablystock, which specifies how many products you have 

in stock. You can then quickly update this when you receive new products from suppliers or sell 

existing ones to customers. 

3. Budget Planning   

You may want to use a spread sheet in your budget planning because it makes it easy for you to 

create and manage several budgets. 

Simply enter the budget items for each month, the beginning balance, create a formula to 

calculate the year-to-date totals and then sum up all of these values at the end. 

4. Inventory Management 

One of Excel’s strengths is its ability to insert large amounts of data quickly. This can be useful 

if you need to keep track of thousands or even millions of products. 

For instance, you could create a spread sheet where one row is created per product and include 

the price in these rows. This way, if you add new products, update prices or remove items from 

stock, you can simply enter the new values into Excel and then write a macro to update your 

inventory system automatically. 

5. Sales & Order Tracking 

Another way to use Excel as a database is by setting up one sheet per order. This allows you to 

create and update records easily and quickly view information such as the customer name and 

address, the list of items ordered their prices, and quantities. 

“Excel and Access have their advantages and disadvantages. It really depends on what you want 

to do with them and how much knowledge you have on the product before deciding which is right 

for you.” 

 

https://www.theexcelexperts.com/using-excel-as-a-database/
https://www.theexcelexperts.com/free-excel-spreadsheet-check/
https://amzn.to/40HY96G
https://www.theexcelexperts.com/vba-consultant/


Choosing Microsoft Access vs. Excel for Your Business 

Both of these software packages have their advantages and disadvantages. It really depends on 

what you want to do with them and how much knowledge you have on the product before 

deciding which is right for you. 

If you need to use a database regularly and need to automate tasks, Microsoft Access may be a 

better choice as it allows you to write VBA code. If you only need the software occasionally or 

want a simple solution for managing data, then Excel is probably more suited for your needs. 

If you need help with databases in Excel or Microsoft Access contact our database experts today. 

We’ve worked with businesses across multiple industries to create professional databases 

solutions for millions of data records. 

 

History 

 

Ben Heron-Grimes 

Ben is the founder and Director/ Head of Data Visualisation at The Excel Experts, a data 

consultancy creating spread sheet-based solutions for a range of B2B and B2C businesses. With 

over 15 years in the industry, Ben has extensive knowledge and skills ranging from data 

organisation and analysis to advanced 3D visualisation. He's also a WUMA-qualified Tai Chi 

instructor. 

 

 

 

 

https://amzn.to/40HY96G
https://www.theexcelexperts.com/contact-us/
https://www.theexcelexperts.com/cut-and-fill/
https://www.theexcelexperts.com/cut-and-fill/
https://www.theexcelexperts.com/cut-and-fill/


Need Help With Excel? 

The Excel Experts are here to help with your Excel tasks big or small, including spread sheet 

help, consulting, reporting, VBA, automation, and Power Bi. Let us help you take your Excel 

skills to the next level with our experience in delivering solutions. 
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What if Analysis-Goalseek, solver & Scenerios 

 

 

Introduction to What-If Analysis 

By using What-If Analysis tools in Excel, you can use several different sets of values in one or 

more formulas to explore all the various results. 

For example, you can do what-If Analysis to build two budgets that each assumes a certain level 

of revenue. Or, you can specify a result that you want a formula to produce, and then determine 

what sets of values will produce that result. Excel provides several different tools to help you 

perform the type of analysis that fits your needs. 

How to use Goal Seek in Excel for What-If analysis 

What-If Analysis is one of the most powerful Excel features and one of the least understood. In 

most general terms, What-If Analysis allows you to test out various scenarios and determine a 

range of possible outcomes. In other words, it enables you to see the impact of making a certain 

change without changing the real data. In this particular tutorial, we will focus on one of Excel's 

What-If Analysis tools - Goal Seek. 

What is Goal Seek in Excel? 

Goal Seek is Excel's built-in What-If Analysis tool that shows how one value in a formula 

impacts another. More precisely, it determines what value you should enter in an input cell to get 

the desired result in a formula cell. 

The best thing about Excel Goal Seek is that it performs all calculations behind the scenes, and 

you are only asked to specify these three parameters: 

• Formula cell 

• Target/desired value 

• The cell to change in order to achieve the target 



The Goal Seek tool is especially useful for doing sensitivity analysis in financial modelling and 

is widely used by management majors and business owner. But there are many other uses that 

may prove helpful to you. 

For instance, Goal Seek can tell you how much sales you have to make in a certain period to 

reach $100,000 annual net profit (example 1). Or, what score you must achieve for your last 

exam to receive an overall passing score of 70% (example 2). Or, how many votes you need to 

get in order to win the election (example 3). 

On the whole, whenever you want a formula to return a specific result but are not sure what input 

value within the formula to adjust to get that result, stop guessing and use the Excel Goal Seek 

function! 

Note. Goal Seek can process only one input value at a time. If you are working on an advanced 

business model with multiple input values, use the Solver add-in to find the optimal solution. 

How to use Goal Seek in Excel 

The purpose of this section is to walk you through how to use the Goal Seek function. So, we'll 

be working with a very simple data set:   

Data set: 

 

 

 

The above table indicates that if you sell 100 items at $5 each, minus the 10% commission, you 

will make $450. The question is: How many items do you have to sell to make $1,000? 

Let's see how to find the answer with Goal Seek: 

1. Set up your data so that you have a formula cell and a changing cell dependent on the formula 

cell. 

2. Go to the Data tab > Forecast group, click the what if Analysis button, and select Goal 

Seek… 

 

3. In the Goal Seek dialog box, define the cells/values to test and click OK: 

o Set cell - the reference to the cell containing the formula (B5). 
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o To value - the formula result you are trying to achieve (1000). 

o By changing cell - the reference for the input cell that you want to adjust (B3). 

 
 

4. The Goal Seek Status dialog box will appear and let you know if a solution has been found. If 

it succeeded, the value in the "changing cell" will be replaced with a new one. Click OK to 

keep the new value or Cancel to restore the original one. 

In this example, Goal Seek has found that 223 items (rounded up to the next integer) need to 

be sold to achieve revenue of $1,000. 

 

If you are not sure you will be able to sell that many items, then maybe you can reach the target 

revenue by changing the item price? To test this scenario, do Goal Seek analysis exactly as 

described above except that you specify different Changing cell (B2): 

 

As the result, you will find out that if you increase the unit price to $11, you can reach $1,000 

revenue by selling only 100 items 



 

Tips and notes: 

• Excel Goal Seek does not change the formula, it only changes the input value that you supply 

to the By changing cell box. 

• If Goal Seek is not able to find the solution, it displays the closest value it has come up with. 

• You can restore the original input value by clicking the Undo button or pressing the Undo 

shortcut (Ctrl + Z). 

Examples of using Goal Seek in Excel 

Below you will find a few more examples of using the Goal Seek function in Excel. The 

complexity of your business model does not really matter as long as your formula in the Set 

cell depends on the value in the Changing cell, directly or through intermediate formulas in other 

cells. 

Example 1: Reach the profit goal 

Problem: It is a typical business situation - you have the sales figures for the first 3 quarters and 

you want to know how much sales you have to make in the last quarter to achieve the target net 

profit for the year, say, $100,000. 

 

Solution: With the source data organized like shown in the screenshot above, set up the 

following parameters for the Goal Seek function: 

• Set cell - the formula that calculates the total net profit (D6). 

• To value - the formula result you are looking for ($100,000). 

• By changing cell - the cell to contain the gross revenue for quarter 4 (B5). 



 

Result: The Goal Seek analysis shows that in order to obtain $100,000 annual net profit, your 

fourth-quarter revenue must be $185,714. 

 

Example 2: Determine the exam passing score 

Problem: At the end of the course, a student takes 3 exams. The passing score is 70%. All the 

exams have the same weight, so the overall score is calculated by averaging the 3 scores. The 

student has already taken 2 out of 3 exams. The question is: What score does the student need to 

get for the third exam to pass the entire course? 

  

Solution: Let's do Goal Seek to determine the minimum score on exam 3: 

• Cell - the formula that averages the scores of the 3 exams (B5). 

• To value - the passing score (70%). 

• By changing cell - the 3rd Set exam score (B4). 



 

Result: In order get the desired overall score; the student must achieve a minimum of 67% on the 

last exam: 

 

 

Example 3: What-If analysis of the election 

Problem: You are running for some elected position where a two-thirds majority (66.67% of 

votes) is required to win the election. Assuming there are 200 total voting members, how many 

votes do you have to secure? 

Currently, you have 98 votes, which is quite good but not sufficient because it only makes 49% 

of the total voters: 

 

  

Solution: Use Goal Seek to find out the minimum number of "Yes" votes you need to get: 



• Set cell - the formula that calculates the percentage of the current "Yes" votes (C2). 

• To value - the required percentage of "Yes" votes (66.67%). 

• By changing cell - the number of "Yes" votes (B2). 

 

 

Result: What-If analysis with Goal Seek shows that to achieve the two-thirds mark or 66.67%, 

you need 133 “yes” votes:  

 

Excel Goal Seek not working 

Sometimes Goal Seek is not able to find a solution simply because it does not exist. In such 

situations, Excel will get the closest value and inform you that Goal Seeking may not have found 

a solution: 

 

 

If you are certain that a solution to the formula you are trying to resolve does exist, check out the 

following troubleshooting tips. 



1. Double check Goal Seek parameters 

First off, make sure the Set cell refers to the cell containing a formula, and then, check if the 

formula cell depends, directly or indirectly, on the changing cell. 

2. Adjust iteration settings 

In your Excel, click File > Options > Formulas and change these options: 

• Maximum Iterations - increase this number if you want Excel to test more possible solutions. 

• Maximum Change - decrease this number if your formula requires more accuracy. For example, 

if you are testing a formula with an input cell equal to 0 but Goal Seek stops at 0.001, 

setting Maximum Change to 0.0001 should fix the issue. 

The below screenshot shows the default iteration settings:

 

3. No circular references 

For Goal Seek (or any Excel formula) to work properly, the involved formulas should not be co-

dependent on each other, i.e. there should be no circular references. 

That's how you perform What-If analysis in Excel with the Goal Seek tool. I thank you for 

reading and hope to see you on our blog next week! 
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Macros & VBA 

 

How to create, change, copy and delete macros 

This tutorial will set you on your way to learning Excel macros. You will find how to record a 

macro and insert VBA code in Excel, copy macros from one workbook to another, enable and 

disable them, view the code, make changes, and a lot more. 

For Excel newbies, the concept of macros often looks insurmountable. Indeed, it may take 

months or even years of training to master VBA. However, this does not mean you cannot take 

advantage of the automation power of Excel macros right away. Even if you are a complete 

novice in VBA programming, you can easily record a macro to automate some of your repetitive 

tasks. 

This article your entry point to the fascinating world of Excel macros. It covers the essential 

basics that you need to know to get started and provides links to the related in-depth tutorials. 

What are macros in Excel? 

Excel macro is a set of commands or instructions stored in a workbook in the form of VBA code. 

You can think of it as a small program to perform a predefined sequence of actions. Once 

created, macros can be re-used anytime. Running a macro executes the commands it contains. 

Typically, macros are used to automate repetitive tasks and daily routines. Skilled VBA 

developers can write really sophisticated macros that go well beyond reducing the number of 

keystrokes. 

Quite often, you may hear people referring to a "macro" as "VBA". Technically, there is a 

distinction: a macro is a piece of code while Visual Basic for Applications (VBA) is the 

programming language created by Microsoft to write macros. 

Why use Excel macros? 

The main purpose of macros is to have more work done in less time. Like you use formulas to 

crunch numbers and manipulate text strings, you can use macros to perform frequent tasks 

automatically. 

Let's say, you are to create a weekly report for your supervisor. For this, you import various 

analytics data from a couple or more external resources. The problem is that those data are 



messy, superfluous, or not in the format that Excel can understand. That means you need to 

reformat dates and numbers, trim extra spaces and delete blanks, copy and paste information into 

appropriate columns, build charts to visualize trends, and do a lot more different things to make 

your report clear and user-friendly. Now, imaging that all these operations can be performed for 

you instantly in a mouse click! 

Of course, building a complex macro takes time. Sometimes, it can take even more time than 

performing the same manipulations manually. But creating a macro is a onetime set-up. Once 

written, debugged and tested, VBA code will do the job quickly and flawlessly, minimizing 

human errors and costly mistakes. 

How to create a macro in Excel 

There are two ways to create macros in Excel - by using the Macro Recorder and Visual Basic 

Editor. 

Tip. Within Excel, most operations with macros are done via the Developer tab, so be sure 

to add Developer tab to your Excel ribbon. 

Recording a macro 

Even if you don't know anything about programing in general and VBA in particular, you can 

easily automate some of your work just by letting Excel record your actions as a macro. While 

you are performing the steps, Excel closely watches and writes down your mouse clicks and 

keystrokes in the VBA language. 

The Macro Recorder captures nearly everything that you do and produces a very detailed (often 

redundant) code. After you've stopped the recording and saved the macro, you can view its code 

in the Visual Basic Editor and make small changes. When you run the macro, Excel goes back to 

the recorded VBA code and executes the exact same moves. 

To start recording, click the Record Macro button on either the Developer tab or the Status bar. 

 

 

Writing a macro in Visual Basic Editor 

The Visual Basic for Applications (VBA) Editor is the place where Microsoft Excel keeps the 

code of all macros, both recorded and written manually. 

In the VBA Editor, you can not only program a sequence of actions, but also create custom 

functions, display your own dialog boxes, evaluate various conditions, and most importantly 

code the logic! Naturally, creating your own macro requires some knowledge of the structure and 

syntax of the VBA language, which is beyond the scope of this tutorial for beginners. But there 

is nothing that would prevent you from reusing someone else's code (say, the one you've found 

on our blog :) and even a complete novice in Excel VBA should have no difficulties with that! 
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First, press Alt + F11 to open the Visual Basic Editor. And then, insert the code in these two 

quick steps: 

1. In the Project Explorer on the left, right-click the target workbook, and then 

click Insert > Module. 

2. In the Code window on the right, paste the VBA code. 

When done, press F5 to run the macro. 

 

 

How to run macros in Excel 

There are several ways to start a macro in Excel: 

• To run a macro from a worksheet, click the Macros button on the Developer tab or press the Alt 

+ F8 shortcut. 

• To run a macro from the VBA Editor, press either: 

o F5 to run the entire code. 

o F8 to go through the code line-by-line. This is very useful for testing and troubleshooting. 

Additionally, you can launch a macro by clicking a custom button or pressing the assigned 

shortcut. 

How to enable macros in Excel 

Because of security reasons, all macros in Excel are disabled by default. So, to use the magic of 

VBA codes to your advantage, you need to know how to enable them. 

The easiest way to turn on macros for a specific workbook is to click the Enable Content button 

in the yellow security warning bar that appears at the top of the sheet when you first open a 

workbook with macros. 



 

 

How to change macro settings 

Microsoft Excel determines whether to allow or disallow VBA codes to be executed in your 

workbooks based on the macro setting selected in the Trust Center. 

Here are the steps to access the Excel macro settings and change them if needed: 

1. Go to the File tab and select Options. 

2. On the left-side pane, select Trust Center, and then click Trust Center Settings… . 

3. In the Trust Center dialog box, click Macro Settings on the left, select the desired option, and 

click OK. 

In the screenshot below, the default macro setting is selected: 

 

 

How to view, edit and debug VBA codes in Excel 

Any changes to the code of a macro, whether it's generated automatically by the Excel macro 

recorder or written by you, are made in the Visual Basic Editor. 

To open the VB Editor, either press Alt + F11 or click the Visual Basic button on 

the Developer tab. 



 

 

To view and edit the code of a specific macro, in the Project Explorer on the left, double-click 

the module that contains it, or right-click the module and pick View Code. This opens the Code 

window where you can edit the code. 

To test and debug a macro, use the F8 key. This will take you through the macro code line-by-

line letting you see the effect that each line has on your worksheet. The line currently being 

executed is highlighted in yellow. To exit debug mode, click the Reset button on the toolbar 

(blue square). 

 

 

How to copy a macro to another workbook 

You created a macro in one workbook and now want to reuse it in other files too? There are two 

ways to copy a macro in Excel: 

Copy the module containing a macro 

In case the target macro resides in a separate module or all the macros in the module are useful 

for you, then it makes sense to copy the whole module from one workbook to another: 

1. Open both workbooks - the one that contains the macro and the one where you wish to copy 

it. 

2. Open the Visual Basic Editor. 



3. In the Project Explorer pane, find the module containing the macro and drag it to the 

destination workbook. 

In the screenshot below, we are copying Module1 from Book1 to Book2: 

 

 

Copy the source code of a macro 

If the module contains many different macros while you need just one, then copy only the code 

of that specific macro. Here's how: 

1. Open both workbooks. 

2. Open the Visual Basic Editor. 

3. In the Project Explorer pane, double-click the module containing the macro that you'd like to 

copy to open its Code window. 

4. In the Code window, find the target macro, select its code (beginning with Sub and ending 

with End Sub) and press Ctrl + C to copy it. 

5. In the Project Explorer, find the destination workbook, and then either insert a new module 

into it (right-click the workbook and click Insert > Module) or double-click an existing 

module to open its Code window. 

6. In the Code window of the destination module, press Ctrl + V to paste the code. If the module 

already contains some code, scroll down to the last code line, and then paste the copied 

macro. 



 

 

How to delete macros in Excel 

If you no longer need a certain VBA code, you can delete it by using the Macro dialog box or the 

Visual Basic Editor. 

Deleting a macro from a workbook 

To delete a macro directly from your Excel workbook, carry out these steps: 

1. On the Developer tab, in the Code group, click the Macros button or press the Alt + 

F8 shortcut. 

2. In the Macro dialog box, select the macro you want to remove and click Delete. 

 



Tips: 

• To view all the macros in all open files, select All Open Workbooks from the Macros in drop-

down list. 

• To be able delete a macro in the Personal Macro Workbook, you need to unhide 

Personal.xlsb first. 

Deleting a macro via Visual Basic Editor 

A benefit of using the VBA Editor is that it enables you to delete an entire module with all the 

macros it contains in one go. Also, the VBA Editor allows deleting macros in the Personal 

Macro Workbook without unhiding it. 

To permanently delete a module, perform these steps: 

1. In the Project Explorer, right-click on the module and choose Remove from the context 

menu. 

2. When asked whether you want to export the module before removing it, click No. 

 

To remove a specific macro, simply delete its source code directly in the Code window. Or, you 

can delete a macro by using the Tools menu of the VBA Editor: 

1. From the Tools menu, choose Macros. The Macros dialog box will appear. 

2. In the Macros In drop-down list, select the project containing the unwanted macro. 

3. In the Macro Name box, select the macro. 

4. Click the Delete button. 
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How to save macros in Excel 

To save a macro in Excel, either recorded or written manually, just save the workbook as macro 

enabled (*.xlms). Here's how: 

1. In the file containing the macro, click the Save button or press Ctrl + S. 

2. The Save As dialog box will appear. Choose Excel Macro-Enabled Workbook 

(*.xlsm) from the Save as type drop-down list and click Save: 

 



How to export and import macros in Excel 

If you'd like to share your VBA codes with someone or move them to another computer, the 

fastest way is to export the entire module as a .bas file. 

Exporting macros 

To export your VBA codes, this is what you need to do: 

1. Open the workbook containing the macros. 

2. Press Alt + F11 to open the Visual Basic Editor. 

3. In the Project Explorer, right-click the Module containing the macros and select Export File. 

4. Navigate to the folder where you want to save the exported file, name the file, and click Save. 

 

Importing macros 

To import a .bas file with VBA codes into your Excel, please follow these steps: 

1. Open the workbook into which you want to import macros. 

2. Open the Visual Basic Editor. 

3. In the Project Explorer, right-click the project name and select Import File. 

4. Navigate to the .bas file and click Open. 



 

Excel macro examples 

One of the best ways to learn Excel VBA is by exploring code samples. Below you will find 

examples of very simple VBA codes that automate some basic operations. Of course, these 

examples won't teach you coding, for this there exist hundreds of professional-grade VBA 

tutorials. We just aim to illustrate a few common features of VBA that will hopefully make its 

philosophy a little more familiar to you. 

Unhide all sheets in a workbook 

In this example, we use the Active Workbook object to return the currently active workbook and 

the For Each loop to go through all the sheets in the workbook one-by-one. For each found 

sheet, we set the Visible property to xlSheetVisible. 

Sub Unhide_All_Sheets () Dim wks. As Worksheet For Each wks. In 

ActiveWorkbook.Worksheets wks. Visible = xlSheetVisible Next wks. End Sub  

 

 

Hide active worksheet or make it very hidden 

To manipulate the currently active sheet, use the Active Sheet object. This sample macro changes 

the visible property of the active sheet to xlSheetHidden to hide it. To make the sheet very 

hidden, set the visible property to xlSheetVeryHidden. 

Sub Hide_Active_Sheet () ActiveSheet.Visible = xlSheetHidden End Sub  



 

 

Unmerge all merged cells in selected range 

If you want to perform certain operations on a range rather than the entire worksheet, use 

the Selection object. For example, the below code will unmerge all the merged cells in a selected 

range at one fell swoop. 

Sub Unmerge Cells () Selection.Cells.UnMerge End Sub  

 

 

Show a message box 

To show some message to your users, use the MsgBox function. Here's an example of such a 

macro in its simplest form: 

Sub Show Message () MsgBox ("Hello World!") End Sub  

In real-life macros, a message box is typically used for information or confirmation purposes. 

For instance, before performing a action (unmerging cells in our case), you display 

a Yes/No message box. If the user clicks "Yes", the selected cells are unmerged. 

Sub Unmerge_Selected_Cells () Dim Answer As String Answer = MsgBox ("Are you sure you 

want to unmerge these cells?” vbQuestion + vbYesNo, "Unmerge Cells") If Answer = vbYes 

Then Selection.Cells.UnMerge End If End Sub  

To test the code, select one or more range containing merged cells and run the macro. The 

following message will appear: 

 

 

 

 

  



Cell reference-Relative, Absolute, Row Absolute & Column 

Absolute, Reference form other sheet 

 

 

 

Relative, Absolute, and Mixed Cell References in Excel and Sheets 
 

A cell reference in spread sheet programs such as Excel and Google Sheets identifies 

the location of a cell in the worksheet. These references use Auto fill to adjust and 

change information as needed in your spread sheet. 

By default, a cell reference is a relative reference, which means that the reference is relative to 

the location of the cell. If, for example, you refer to cell A2 from cell C2, you are actually 

referring to a cell that is two columns to the left (C minus A)—in the same row (2). When you 

copy a formula that contains a relative cell reference, that reference in the formula will change. 

As an example, if you copy the formula =B4*C4 from cell D4 to D5, the formula in D5 adjusts 

to the right by one column and becomes =B5*C5. If you want to maintain the original cell 

reference in this example when you copy it, you make the cell reference absolute by preceding 

the columns (B and C) and row (2) with a dollar sign ($). Then, when you copy the 

formula =$B$4*$C$4 from D4 to D5, the formula stays exactly the same. 

 

 Note: The information in this article applies to Excel versions 2019, 2016, 2013, Excel 

for Mac, Excel Online, and Google Sheets. 

 

https://www.lifewire.com/google-sheets-4157491
https://www.lifewire.com/what-is-a-spreadsheet-cell-4178208


 

Less often, you may want to mixed absolute and relative cell references by preceding either the 

column or the row value with a dollar sign—which fixes either the column or the row (for 

example, $B4 or C$4). 

To change the type of cell reference: 

1. Select the cell that contains the formula. 

2. In the formula bar , select the reference that you want to change. 

3. Press F4 to switch between the reference types. 

The table below summarizes how a reference type updates if a formula containing the 

reference is copied two cells down and two cells to the right. 

 

The Different Types of Cell References 

The three types of references that can be used in Excel and Google Sheets are easily identified by 

the presence or absence of dollar signs ($) within the cell reference. A dollar sign tells the 

program to use that value every time it runs a formula. 

• Relative cell references contain no dollar signs (i.e., A1). 

• Mixed cell references have dollar signs attached to either the letter or the number in a 

reference but not both (i.e., $A1 and A$1). 

• Absolute cell references have dollar signs attached to each letter or number in a 

reference (i.e., $A$1). 

You'll typically use an absolute or mixed cell reference if you set up a formula. For example, if 

you have a number in Cell A1, more numbers in Column B, and Column C contains the sums of 

A1 and each of the values in B, you'll use "$A$1" in the SUM formula so that when you auto fill, 

the program knows to always use the number in A1 instead of the empty cells below it. 

 

A cell is one of the boxlike structures that fill a worksheet, and you can locate one by its 

references, such as A1, F26, or W345. A cell reference consists of the column letter and row 

number that intersect at the cell's location. When listing a cell reference, the column letter always 

appears first. Cell references appear in formulas, functions, charts, and other Excel commands. 

How Cell References Use Automatic Updating 

One advantage of using cell references in spread sheet formulas is that, normally, if the data 

located in the referenced cells changes, the formula or chart automatically updates to reflect the 

change. 
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If a workbook has been set not to update automatically when you make changes to a worksheet, 

you can carry out a manual update by pressing the F9 key on the keyboard. 

You Can Reference Cells From Different Worksheets 

Cell references are not restricted to the same worksheet where the data is located. Other 

worksheets in the same file can reference each other by including a notation that tells the 

program which sheet to pull the cell from. 

You don't need a sheet notation if you're referring to a cell in the same worksheet. 

Similarly, when you reference data in a different workbook, the name of the workbook and the 

worksheet are included in the reference along with the cell location. 

To reference a cell on a different sheet, preface the cell reference with "Sheet [number]" with an 

exclamation point after it, and then the name of the cell. So if you want to pull info from Cell A1 

in Sheet 3, you'll type, "Sheet3! A1." 

A notation referring to another workbook in Excel also includes the name of the book in 

brackets. To use the information contained in Cell B2 in Sheet 2 of Workbook 2, you'll type, 

"[Book2] Sheet2!B2." 

Cell Range: A Quick Primer 

While references often refer to individual cells, such as A1, they can also refer to a group 

or range of cells. You identify ranges of cells by the starting and ending cells. In the case of 

ranges that occupy multiple rows and columns, you'll use the cell references of the cells in the 

upper left and lower right corners of the range. 

Separate the limits of a cell range with a colon ( : ), which tells Excel or Google Sheets to 

include all the cells between these start and end points. So to grab everything between Cell A1 

and D10, you'd type, "A1:D10." 

To capture an entire row or column, you still use the cell range notation, but you only use the 

column numbers or row letters. To include everything in Column A, the range will be "A:A." To 

use Row 8, you'll type, "8:8." For everything in Columns B through D, you'll type, "B:D." 

Copying Formulas and Different Cell References 

Another advantage of using cell references in formulas is that they make it easier to copy 

formulas from one location to another in a worksheet or workbook. 

Relative cell references change when copied to reflect the new location of the formula. 

The name relative comes from the fact that they change relative to their location when copied. 

This is usually a good thing, and it is why relative cell references are the default type of 

reference used in formulas. 

At times, cell references need to stay static when formulas are copied. Copying formulas is the 

other major use of an absolute reference such as =$A$2+$A$4. The values in those references 

don't change when you copy them. 

At other times, you may want part of a cell reference to change, such as the column letter, while 

having the row number stay static or vice versa when you copy the formula. In this case, you'll 

use a mixed cell reference such as =$A2+A$4. Whichever part of the reference has a dollar sign 

attached to it stays static, while the other part changes when copied. 

So for $A2, when it is copied, the column letter is always A, but the row numbers change to 

$A3, $A4, $A5, and so on. 
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The decision to use the different cell references when creating the formula is based on the 

location of the data that the copied formulas will use. 

Toggling Between Types of Cell References 

The easiest way to change cell references from relative to absolute or mixed is to press 

the F4 key on the keyboard. To change existing cell references, Excel must be in edit 

mode, which you enter by double-clicking on a cell with the mouse pointer or by pressing 

the F2 key on the keyboard. 

To convert relative cell references to absolute or mixed cell references: 

• Press F4 once to create a cell reference fully absolute, such as $A$6. 

• Press F4 a second time to create a mixed reference where the row number is absolute, 

such as a$6. 

• Press F4 a third time to create a mixed reference where the column letter is absolute, such 

as $A6. 

• Press F4 a fourth time to make the cell reference relative again, such as A6. 

 

  

  



Row and Column cell references (R1C1) 

 

Excel normally displays cell references in the A1 style i.e with rows each given a number and 

columns given an alphabetic character. 

 

Absolute or Relative cell references determine whether ranges are incremented as they are 

copied to other cells. Placing the dollar symbol ($) in front of a column letter or row number will 

fix it if the formula is copied to other cells. If the relative formula SUM(A5:A10) is copied to the 

adjacent cell, it will update to SUM(B5:B10). The absolute formula SUM($A$5:$A$10) will 

refer to the same range, regardless of where it is copied to. 

 

Excel can also handle cell references using a different format or notation. The R1C1 notation 

describes a cell location in terms of a row number and a column number. It can also distinguish 

between absolute and relative references. R5C1 is an absolute reference (for cell $A$5) whereas 

R[4]C[1] is four rows below and one column to the right, relative to the current cell. 

 

 

 

In the above example the formulas in Cells C9, D9 and E9 are shown in both A1 and R1C1 

notation. The first formula contains absolute references. The next two are relative formulas. Note 

however that in R1C1 format, these two are identical. 

Select File | Options and Formulas to modify the worksheet appearance and display references as 

R1C1. Formulas change and column labels will switch from letters to numbers. 



 

 

Use Excel options to toggle the Style                       Worksheet with R1C1 references ON 

 

These alternative R1C1 references can be applied using the Indirect function without switching 

Excel's formula properties. e.g. =SUM(INDIRECT("R[-5]C[0]:R[-1]C[0]",0)) will sum the five 

cells above the current cell. Note that an extra argument must be supplied to the Indirect 

function. =INDIRECT(TextRng, Type_TF). If TextRng is an R1C1 reference, the optional 

Type_TF argument must be set to FALSE or zero. If it is any other value or omitted the TextRng 

is assumed to be in normal A1 notation. 

The next example uses the Indirect function to read the R1C1 style reference in cell F1. That 

string in turn reflects the month number in cell D2. The reference currently represents the first 3 

columns of values on the current row. The nature of R1C1 references means that the exact same 

range string can be applied (using INDIRECT) against all of the cells in G4:G7. With the A1 

notation a different INDIRECT reference would be required for each row. This example has been 

created to demonstrate INDIRECT() and R1C1 references. If I was trying to construct a table 

like this with dynamic formulas I would probably use INDEX() or OFFSET() in preference to 

this method. 

 

 

In the following (embedded web app) example you can edit the month number value in cell D3 

and thereby change the R1C1 string in cell F1. This string is used in each row in column G to 

supply the INDIRECT function with a dynamic range. 

 



 

 

R1C1 references are most useful when writing Visual Basic code. If you wish to use VBA to 

write cell formulas, it is much easier to write code to increment 1, 2, 3 rather than A, B, C. Also, 

a single R1C1 formula with relative references can be copied (using VBA) to a range of cells and 

will adjust to the appropriate rows and columns. 

 

How to Create Named Ranges in Excel 

What’s in the name? 

If you are working with Excel spreadsheets, it could mean a lot of time saving and efficiency. 

  



Named Ranges in Excel – An Introduction 

If someone has to call me or refer to me, they will use my name (instead of saying a male is 

staying in so and so place with so and so height and weight). 

Right? 

Similarly, in Excel, you can give a name to a cell or a range of cells. 

Now, instead of using the cell reference (such as A1 or A1:A10), you can simply use the name 

that you assigned to it. 

For example, suppose you have a data set as shown below: 

 

In this data set, if you have to refer to the range that has the Date, you will have to use A2:A11 in 

formulas. Similarly, for Sales Rep and Sales, you will have to use B2:B11 and C2:C11. 

While it’s alright when you only have a couple of data points, in case you have huge complex 

data sets, using cell references to refer to data could be time-consuming. 

Excel Named Ranges makes it easy to refer to data sets in Excel.  

You can create a named range in Excel for each data category, and then use that name instead of 

the cell references. For example, dates can be named ‘Date’, Sales Rep data can be named 

‘SalesRep’ and sales data can be named ‘Sales’. 



 

You can also create a name for a single cell. For example, if you have the sales commission 

percentage in a cell, you can name that cell as ‘Commission’. 

Benefits of Creating Named Ranges in Excel 

Here are the benefits of using named ranges in Excel. 

Use Names instead of Cell References 

When you create Named Ranges in Excel, you can use these names instead of the cell references. 

For example, you can use =SUM(SALES) instead of =SUM(C2:C11) for the above data set. 

Have a look at ṭhe formulas listed below. Instead of using cell references, I have used the Named 

Ranges. 

● Number of sales with value more than 500: =COUNTIF(Sales,”>500″) 

● Sum of all the sales done by Tom: =SUMIF(SalesRep,”Tom”,Sales) 

● Commission earned by Joe (sales by Joe multiplied by commission percentage): 

=SUMIF(SalesRep,”Joe”,Sales)*Commission 

You would agree that these formulas are easy to create and easy to understand (especially when 

you share it with someone else or revisit it yourself. 

No Need to Go Back to the Dataset to Select Cells 

https://trumpexcel.com/absolute-relative-mixed-cell-references/
https://trumpexcel.com/excel-countif-function/
https://trumpexcel.com/excel-sumif-function/


Another significant benefit of using Named Ranges in Excel is that you don’t need to go back 

and select the cell ranges. 

Named Ranges Make Formulas Dynamic 

By using Named Ranges in Excel, you can make Excel formulas dynamic. 

For example, in the case of sales commission, instead of using the value 2.5%, you can use the 

Named Range. 

Now, if your company later decides to increase the commission to 3%, you can simply update 

the Named Range, and all the calculations would automatically update to reflect the new 

commission. 

How to Create Named Ranges in Excel 

Here are three ways to create Named Ranges in Excel: 

Method #1 –  Using Define Name 

Here are the steps to create Named Ranges in Excel using Define Name: 

● Select the range for which you want to create a Named Range in Excel. 

 

• Go to Formulas –> Define Name. 

https://trumpexcel.com/excel-functions/


 

In the New Name dialogue box, type the Name you wish to assign to the selected data range. 

You can specify the scope as the entire workbook or a specific worksheet. If you select a 

particular sheet, the name would not be available on other sheets. 

 

● Click OK. 

This will create a Named Range SALES REP. 

Method #2: Using the Name Box 

● Select the range for which you want to create a name (do not select headers). 

● Go to the Name Box on the left of the Formula bar and Type the name of the with which 

you want to create the Named Range.  

● Note that the Name created here will be available for the entire Workbook. If you wish to 

restrict it to a worksheet, use Method 1. 

Method #3: Using Create From Selection Option 

This is the recommended way when you have data in tabular form, and you want to create a 

named range for each column/row. 

For example, in the dataset below, if you want to quickly create three named ranges (Date, 

Sales_Rep, and Sales), then you can use the method shown below. 

https://trumpexcel.com/name-box-excel/


 

Here are the steps to quickly create named ranges from a dataset: 

• Select the entire data set (including the headers). 

• Go to Formulas –> Create from Selection (Keyboard shortcut – Control + Shift + F3). It 

will open the ‘Create Names from Selection’ dialogue box. 

 

• In the Create Names from Selection dialogue box, check the options where you have the 

headers. In this case, we select the top row only as the header is in the top row. If you 

have headers in both the top row and left column, you can choose both. Similarly, if your 

data is arranged when the headers are in the left column only, then you only check the 

Left Column option. 

 

This will create three Named Ranges – Date, Sales_Rep, and Sales. 



Note that it automatically picks up names from the headers. If there are any space between 

words, it inserts an underscore (as you can’t have spaces in named ranges). 

Naming Convention for Named Ranges in Excel 

There are certain naming rules you need to know while creating Named Ranges in Excel: 

● The first character of a Named Range should be a letter and underscore character(_), or a 

backslash(\). If it’s anything else, it will show an error. The remaining characters can be 

letters, numbers, special characters, period, or underscore. 

● You can not use names that also represent cell references in Excel. For example, you 

can’t use AB1 as it is also a cell reference. 

● You can’t use spaces while creating named ranges. For example, you can’t have Sales 

Rep as a named range. If you want to combine two words and create a Named Range, use 

an underscore, period or uppercase characters to create it. For example, you can have 

Sales_Rep, SalesRep, or SalesRep. 

● While creating named ranges, Excel treats uppercase and lowercase the same way. For 

example, if you create a named range SALES, then you will not be able to create another 

named range such as ‘sales’ or ‘Sales’. 

● A Named Range can be up to 255 characters long. 

 

 

 

 

 

  



What Are Excel Errors 

Excel is a powerful tool for working with data, but it can also be frustrating when errors occur. 

While some errors are easy to fix, others can be more difficult to troubleshoot. By understanding 

the different types of Excel errors, you can learn how to avoid them and quickly fix them when 

they occur. This will help you save time and ensure that your Excel workbooks are accurate and 

error-free. 

 

Below is the list of some most common errors that we can find in the Excel formula: 

1. #NAME? Error: This Excel error usually occurs because of the non-existent function. 

2. #DIV/0! Error: This Excel error because if we try to divide the number by zero or vice-

versa. 

3. #REF! Error: This error arises due to a reference missing. 

4. #NULL! Error: This error comes due to unnecessary spaces inside the function. 

5. #N/A Error: The function cannot find the required data. Maybe the wrong reference is 

given. 

6. ###### Error: This is not a true Excel formula error, but it occurs because of a 

formatting issue. Probably, the value in the cell is more than the column width. 

7. #VALUE! Error: This is one of the common Excel formula errors we see in Excel. It 

occurs due to the wrong data type of the parameter given to the function. 

8. #NUM! Error: Excel formula error because the number we have supplied to the formula 

is not proper. 

#1 #NAME? Error 

The #NAME? Excel formula error is when Excel cannot find the supplied function or the 

parameters we gave do not match the standards of the function. 

 

Just because of the display value of #NAME? It does not mean Excel is asking your name. 

Rather, it is due to the wrong data type for the parameter. 

 



If we notice in the formula bar, instead of the Sum formula in excel , we have misspelt the 

formula as su. So the result of this function is #NAME?. 

How to Fix the #Name? ERROR Issue? 

To fix the Excel formula error, we must look for the formula bar and check if the formula we 

have inserted is valid. If the formula spelling is inaccurate, we must change that to the correct 

wording. 

 

 

#2 #DIV/0! Error 

The #DIV/0! Error is due to the wrong calculation method, or one of the operators is missing. 

This error occurs in calculations. For example, if we have a “Budgeted” number in cell A1 and 

the “Actual” number in cell B1, we must divide the B1 cell by the A1 cell to calculate the 

efficiency. If any cells are empty or zero, we may get this error. 

 

 

 

How to Fix the #DIV/o! ERROR Issue? 

To fix this Excel formula error, we must use one formula to calculate the efficiency level. 

Therefore, we can use the IFERROR function in excel 

 and calculate inside the function. 

 

https://www.wallstreetmojo.com/iferror-excel-function/


 

 

 

#3 #REF! Error  

The #REF! Error is due to the supply of the reference missing suddenly. Look at the below 

example in cell B2. We have applied the formula “A2 + C2.” 

 

 

 

Now, we will delete column C2 and see the result in cell B2. 

 

 

 

How to Fix the #REF! ERROR Issue? 

Before adding or deleting anything to the existing data set, we must ensure all the formulas are 

pasted as values. If the deleting cell is referred to any of the cells, we may encounter this error. 



We must always undo the action if we accidentally delete any rows, columns, or cells. 

#4 #NULL! Error 

The #NULL! Error is due to the wrong value supplied to the required parameters; for 

example, after the improper supply of range operator, incorrect mention of parameter 

separator. 

Look at the below image. We have applied the SUM formula to calculate the sum of the values 

in cells A2 and B2. The mistake we made here is after the first argument. We should give a 

comma (,) to separate the two arguments. Instead, we have provided space. 

 

How to Fix the #NULL! ERROR Issue? 

In these cases, we need to mention the exact argument separators. For example, we should use 

the comma (,) after the first argument in the above image. 

 

In the case of a range, we need to use a colon (:). 

 



#5 #VALUE! Error 

The #VALUE! error occurs if the formula cannot find the specified result. It is due to non-

numerical values or wrong data types to the argument. 

Look at the image below. We have calculated the commission amount based on the sales value 

and commissions. 

 

If we notice the cells D6 and D8, we get an error as #VALUE!. The reason we got #VALUE! 

Error because there is no commission percentage in the cells C6 and C8. 

We cannot multiply the text value with numerical values. 

How to Fix the #VALUE! ERROR Issue? 

In these cases, we must replace all the text values with zero until we get further information. 

 

#6 ###### Error 

The ###### error, is not an error. Rather, it is just a formatting issue. For example, look at the 

below image in cell A1 that has entered the date values. 

 

 

 



It is due to the length issue of the characters. The values in the cell are more than the column 

width. In simple terms, the column width is not wide enough. 

 

How to Fix the ###### ERROR Issue? 

We must double-click on the column to adjust the column width 

 to get the full values visible. 

 

 

 

 

#7 #N/A! Error 

The #N/A! error is because the formula cannot find the value in the data. It usually occurs when 

the Excel lookup functions like VLOOKUP, HLOOKUP, MATCH, and VLOOKUP cannot find 

the value you are looking for within the formula in the specified range. 

 

 

We got some errors as #N/A in the cells E6, E8, and E9. If we look at the ranges for these cells, 

it does not include the values against those IDs. 

 

https://www.wallstreetmojo.com/excel-column-width/
https://www.shiksha.com/online-courses/articles/vlookup-in-excel/
https://www.shiksha.com/online-courses/articles/hlookup-in-excel/
https://www.shiksha.com/online-courses/articles/index-and-match-in-excel/
https://www.shiksha.com/online-courses/articles/xlookup-in-excel/
https://www.shiksha.com/online-courses/articles/xlookup-in-excel/


 

ID 156 is not in the range from A6 to B13; we got an error. Similarly, for the remaining two 

cells, we have the same issue. 

How to Fix the #N/A! ERROR Issue? 

We need to make this an absolute reference when referencing a table range. 

 

 

We must press the F4 key to make it an absolute reference. 

 

#8 #NUM! Error 

Excel error occurs when Excel usually cannot display the result of a mathematical operation. 

This type of error can occur for two reasons: 

For example, a formula or function contains numeric values that aren’t valid. Calculating the 

square root of a negative number =SQRT(-8). This is because, in Excel, imaginary numbers are 

not considered. 

https://www.wallstreetmojo.com/absolute-reference-in-excel/


 

Or it can also be because the result of an operation is too large or small for Excel to display it. 

For example: Calculating the power of 1000 raised to 300 =POWER(1000,300) will give us a 

result Excel error type #NUM! 

 

How to Fix the #NUM! ERROR Issue? 

To fix this error in Excel, change the number of times Excel iterates the formula – 

1. Go to File < Options. 

2. The dialogue box will open. Go to Formulas and then Calculation options. Check the 

Enable iterative calculation box. 

3. You will see two options – Maximum Iterations and Maximum Change. In the Maximum 

Iterations box, mention the number of times you want Excel to recalculate. The number 

of iterations is directly proportional to the time Excel takes to calculate a worksheet. 

4. Now type the amount of change you will accept between calculation results in the 

Maximum Change box. The smaller the number, the less time Excel calculates a 

worksheet. 

 

 

 

 



 

Excel Auditing Tools: 

Excel auditing tools provide a suite of functionalities that will enable you to review, validate, and 

troubleshoot formulas and data. Suppose we have a dataset of some projects’ Principal Amount, 

Interest Amount, Monthly Amount, and Interest Rate. Now we will apply all the auditing tools 

using this data table. 

 

                    

 

Advantages of  Using  Excel Auditing Tools 

• Auditing tools like “Trace Dependents” and “Trace Precedents” help identify cells that 

contribute to a specific formula, making it easier to locate errors. 

• The “Show Formulas” feature allows you to view the actual formulas in cells, aiming 

toward understanding complex calculations. 

• Tools like “Error Checking” automatically detect and highlight common errors like 

division by zero or incorrect cell references, aiding in quick error resolution. 

  



 

Trace Precedents 

 

Trace Precedents is a dynamic tool to sort out the complex chain of cell relationships in 

your spreadsheets. Trace Precedents provide you the ability to understand formula 

dependencies by highlighting the connections that have an impact on a chosen cell. As we 

have calculated the interest amount by multiplying the principal amount with the interest rate, 

let’s see what the trace precedent tool show for this calculation. 

• To do so, choose a cell (D5), and visit the Trace Precedents option from the Formulas 

tab. 

• As a result, we will see two arrows from cell (C5) and cell (C11) indicating towards cell 

(D5) as the interest amount is calculated using the principal amount and interest rate. 



● 

Trace Dependents 

In order to visually highlights the cells that depend on the value of a selected cell, you 

can try the Trace Dependents feature in Excel. This is a powerful tool for understanding the 

relationship between cells. Here, let’s see how the interest rate is dependent on the 

cells. 

 

• Simply, choose a cell (G22), and then visit the Trace Dependents feature from the Formulas 

tab. 

Finally, you will see the arrows from the cell (G11) to other cells indicating the cells that are 

dependent on the value of the selected cell. 



Remove Arrows 

After inserting arrows using the above features, you can also delete them by utilizing the 

Remove Arrows option. 

• Start with, selecting the cell (C11) and clicking the 

Remove Arrows option from the Formulas tab. 

• Within a blink of an eye, the arrows will be removed. 

It’s that simple. 

 

 

  



Show Formulas 
 

Show Formulas in Excel is a helpful tool that  allows  you to view the actual formulas within 

cells instead of their calculated results. This feature offers transparency into complex 

calculations, aiding in formula debugging and verification. 

• While the worksheet is open, visit the Formulas tab and press the Show Formulas option. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Immediately, all the cells with formulas will represent the formulas inside the cells. 

 

 



Error Checking (Includes Error Checking, Trace Error, Circular References) 

Sometimes while applying formulas, you will get errors like 

 

#DIV/0!, #VALUE!, #NAME? Errors. To check why it’s happening you can visit Error 

Checking option from the Formula tab. 

• Select a cell (E5), and hit the Error Checking 

option from the Formulas tab. 

• Now, you can click the Help on this Error option to 

check in detail about the error. 



• As a result, a new window will open in your browser providing you details about the error and its 

solution. 

 

 

• In order to trace from which cells these are happening, click the Trace Error option from 

the Formulas tab. 



• Immediately, an arrow will appear to indicate the error and its corresponding cells. 

 



Evaluate Formula 

When you are dealing with complex formulas and you are having trouble understanding 

the formulas, at that time you can visit the Evaluate Formula option to have a better 

understanding. 

• Simply, choose a cell (E5) consisting of the formula and hit the Evaluate Formula option. 

 

• Immediately, a window will open evaluating the formula. 

• From there to evaluate more deeply click the Evaluate option. 



Another update will come describing the formula. Click Evaluate again to get the result. 

 

• After completing the evaluation, you will get the cell value in the window. 



Watch Window 

While working with a large dataset sometimes you might need to look over some cell 

values immediately and all time in a specific space. For that, you can add a watch 

window at the top of the spreadsheet. Here, we have calculated the total monthly 

payment amount using the SUM function in Excel. 

Now we will add a watch window for this specific cell. 

• Choose a cell (C12), apply the below formula, and hit ENTER. 

 

• Now choosing the cell (C12), hit the Watch Window feature from the Formulas tab. 

 

10% 

$145,7

10% 
$145,750 



 

 

 



• Within a glimpse, a window will open at the top of the spreadsheet showing cell value and 

formula. This watch window is really a helpful tool for making a summary of your 

dataset. And if you scroll or jump to another sheet the watch window will always be 

visible on that place. 

 

 

  



Array Formulas in Excel 

Excel is among the most powerful and widely used spreadsheet tools which eases organizing 

numbers and data within the sheets with pre-built formulas and functions. In this article, we are 

going to study Array Formulas. Arrays are one of them. Using Excel Array Formulas, make it 

super easy to handle a lot of data. Before understanding and using the Array formulas, let’s first 

understand what is Array in Excel?  

Array in Excel 

An Array in Excel is the structure that holds a collection of data. These data can be in the form of 

numbers or texts. There could be an array of 1-D or 2-D as well in Excel. For example, the array 

of fruits in excel would be written something like this:- 

{“Apple”, “Banana”, “Grapes”, “Guava”} 

We can directly enter it into the sheet by selecting the cells where you want to enter the data and 

then writing the array preceded by an “=” sign.  After these press Ctrl+Shift+Enter. For example, 

let’s enter these values in cells A1 to D1. 

Array-in-excel 

The array created here is a horizontal array. You can also create a vertical array by changing the 

selected cells. You can create an array by specifying the starting and the ending positions, for 

example, if you wish to make an array of elements between A1 to F1 then you can write A1:F1. 

Now. let’s move to array formulas. 

Array formulas 

Array formulas enable to process of several values and give several outputs. In a simple world, it 

can do multiple calculations and reduce a lot of human efforts. In other words, we can say that it 

solves array calculations and give an array as output too. Let’s understand more of them with an 

example, of students with their test marks, 

 

Here, we have used a formula to evaluate the result in the ‘Total’ field. For inserting the formula, 

click on the cell where you want to store the answer and write the formula. Now, let’s try to 

calculate the same for all students 



 

For calculating the total for all the students, select the field where you want to store them, now 

select the range, and insert the formula. Array formulas are available in every version of Excel, 

so you don’t worry about your excel version. There are hundreds of operations possible using 

array formulas, which we will discuss in this article later. But before proceeding let’s understand 

what is the need to use an array formula. 

Why use an Array Formula? 

Array formulas are to most powerful yet most easy-to-use calculation tools which could be used 

to perform complex calculations and take place of hundreds of formulas with a single formula. 

You can further specify conditions for the calculation of data. Not just calculations you can also 

count the chars in cells, add date, day, or time, and even pick random data.  

How to insert an Array Formula? 

Before entering the Array formula fir of all we understand some important points about the 

Array formula: 

• After typing the formula you have to press keys CTRL+SHIFT+ENTER together. It will 

automatically change the normal formula into an array formula.  

• If you manually type braces around the formula then it will not convert the formula into 

an array formula. You have to use CTRL+SHIFT+ENTER keys to convert the formula 

into an array formula. 

• Whenever you edit the array formula the braces will disappear automatically and you 

have to again press the combination of CTRL+SHIFT+ENTER keys. 

• If you forget to press the CTRL+SHIFT+ENTER keys then your formula will work as 

the normal formula. 

Now let’s understand inserting an array formula. 

Single Cell Array formula 

Every array formula returns the result in either single or in multiple cells. So when an array 

formula returns its result in the single-cell then such type of formula is known as a single-cell 

array formula. Such types of formulas are SUM, AVERAGE, AGGREGATE, MAX, MIN, etc. 

Follow the following steps to use the single-cell array formula: 

Step 1: Select the cell where you want to store the answer. 



Step 2: Now go to the formula bar and write an “=” sign. 

Step 3: Now to formulas (highlighted below), and select the operation you want to perform. 

 

Single-cell-array 

Step 4: Here we want to perform the sum operation. Click on sum and a new popup will open. Write the 

cells you want to perform the operation with. 

 

Function-arguments 

Multi-Cell Array Formula 

If you wish to perform the same calculation with more cells then you can use the multi-cell 

formula. You can implement it in two ways. Functions like TRANSPOSE, TREND, 



FREQUENCY, LINEST, etc are used for the multi-cell arrays. Implement the formula in single-

cell by following the above steps. Now, drag the selection up to the cells you want to implement 

the formula. Below is the implementation of doing that. 

 

Multi-cell-array-formula 

Alternatively, 

Specify the range of cells and an operator between them. For example, =(B1:B7 + C2:C7) and 

press Ctrl+Shift+Enter.  

 

Operator-in-multi-cell 

Excel Array Constants 

Excel array contacts are a set of static values and can’t be changed. These values remain constant 

regardless of the operations performed on them. Now we will see how to create Array Constants 

in Excel and will perform different actions on them. There are three types of array constant 

available: 

1. Horizontal or Row Array constant 

A horizontal constant is present in a row. To create a horizontal constant we have to type 

multiple values separated by a comma in the enclosed braces. To enter a row array follow these 

steps below: 

Step 1: Select the cells you want to work with. 

Step 2: Go to the formula bar and start with an equal sign.  



Step 3: Now enter the array you want to create in braces {}, separated by commas(,). Ex:- 

={1,2,3,4,5} 

Step 4: Now press Ctrl+Shift+Enter. 

 

Horizontal-or-Row-Array-constant 

2. Vertical or Column Array 

Vertical array constants are generally present in Column Array. To create a vertical constant we 

have to type multiple values separated by a semicolon in the enclosed braces. To enter a column 

array follow these steps below: 

 

Step 1: Select the cells you want to work with. 

step 2: Go to the formula bar and start with an equal sign.  

Step 3: Now enter the array you want to create in braces {} separated with termination sign(;). 

Ex:- ={“Coding”;”GFG”;”GeeksforGeeks”} 

Step 4: Now press Ctrl+Shift+Enter. 

 

Vertical-or-Column-Array 

3. 2-D array 

In Excel, you are allowed to create a 2-D array. So to create a 2-D array constant, we have to 

type multiple values in which rows are separated by semicolons and d columns are separated by 

commas. Let’s understand the implementation of a 2-d array.  

Step 1: Select the cells you want to work with. 

Step 2: Go to the formula bar and start with an equal sign.  

Step 3: Now enter the array you want to create in braces {} separated with commas(,) for 

entering the values in same row, termination sign(;) for row change. Ex:- 

={1,2,3;”Coding”,”GFG”,”GeeksforGeeks”} 

Step 4: Now press Ctrl+Shift+Enter. 



Working with Constant arrays 

In the Excel formula, array constants are the important part. Some of the important concepts of 

Array constant are: 

1. Elements: To create elements of array constant we have to follow the following points: 

1. The elements of an array constant must be of numeric, alphabetic, boolean, or scientific 

notation and each of them is separated by commas or semicolons. 

2. The elements of an array constant do not contain an array, cell reference, dates functions 

formulas, defined names, etc. 

3. You can also be allowed to use text in the array of the element but the text is surrounded 

by hyphens(“”).  

2. Naming Array Constants: You can name any array and use them as a variable for further 

references. For naming an array, follow the steps below: 

1. Go to the formula tab. and select Define Name. 

2. Write the array name in the name. You can also add some comments related to your 

array. 

3. Click on OK. 

 
 

 

3. Common Errors: Following are the common errors that will happen while working with 

array constants: 

1. The use of delimiters in between the elements. 

2. The selection of range is also an important point to remember.  

Unary Operator in Excel Array Formulas 

Using unary operators we can process the array using AND and OR operators.  

1. AND: It is denoted by an asterisk(*) symbol. It returns true if and only if all conditions 

are true,  

2. OR: It is denoted by a plus(+) symbol. It returns true if any of the statement is true. 



These operators are more useful when you have the same variable with a different value. For 

example, let’s consider a case, where data of 3 sellers of different months are given and you have 

to how much Shyam sold potatoes. 

 

 

Using-and-operator 

 

 

  



Excel Lookup - the basics 

Before we dive into the arcane twists of Excel Lookup formulas, let's define the key terms to 

ensure that we are always on the same page. 

Lookup - searching for a specified value in a table of data. 

Lookup value - a value to search for. 

Return value (matching value or match) - a value at the same position as the lookup value but in 

another column or row (depending on whether you do vertical or horizontal lookup). 

Lookup table. In computer science, a lookup table is an array of data, which is generally used to 

map input values to output values. In terms of this tutorial, an Excel lookup table is nothing else 

but a range of cells where you search for a lookup value. 

Main table (master table) - a table into which you pull matching values. 

Your lookup table and main table may have different structure and size, however they should 

always contain at least one common unique identifier, i.e. a column or row that holds identical 

data, depending on whether you want to perform a vertical or horizontal lookup. 

The following screenshot shows a sample lookup table that will be used in many of the below 

examples. 

 

Excel Lookup functions 

Below is a quick overview of the most popular formulas to perform lookup in Excel, their main 

advantages and drawbacks. 

LOOKUP function 

The LOOKUP function in Excel can perform the simplest types of vertical and horizontal lookups. 

Pros: Easy-to-use. 

Cons: Limited functionality, cannot work with unsorted data (requires sorting the lookup 

column/row in ascending order). 

For more information, please see How to use Excel 

LOOKUP function. 



VLOOKUP function 

It's an improved version of the LOOKUP function specially designed to do vertical lookup in 

columns. 

Pros: Relatively easy to use, can work with exact and approximate match. 

Cons: Cannot look at its left, stops working when a column is inserted into or removed from the 

lookup table, a lookup value cannot exceed 255 characters, requires much processing power on 

large datasets. 

For more information, please see Excel VLOOKUP tutorial for beginners. 

 

HLOOKUP function 

It's a horizontal counterpart of VLOOKUP that searches for a value in the first row of the lookup 

table and returns the value in the same position from another row. 

Pros: Easy to use, can return exact and approximate matches. 

Cons: Can only search in the topmost row of the lookup table, is affected by the insertion or 

deletion of rows, a lookup value should be under 255 characters. 

For more information, please see How to use HLOOKUP in Excel. 

 

VLOOKUP MATCH / HLOOKUP MATCH 

A dynamic column or row reference created by MATCH makes this Excel lookup formula 

immune to the changes made in the dataset. In other words, with some help from MATCH, the 

VLOOKUP and HLOOKUP functions can return correct values no matter how many 

columns/rows have been inserted to or deleted from a lookup table. 

 

Formula for Vertical lookup 

 

 

 

 

Formula for Horizontal lookup 

 

 

VLOOKUP(lookup_value, lookup_table, 

MATCH(return_column_name, column_headers, 0), 

FALSE) 

HLOOKUP(lookup_value, lookup_table, 

MATCH(return_row_name, row_headers, 0), FALSE) 



Pros: An improvement over regular Hlookup and Vlookup formulas immune to data insertion or 

deletion. 

Cons: Not very flexible, requires a specific data structure (the lookup value supplied to the 

MATCH function should be exactly equal to the name of the return column), cannot work with 

lookup values exceeding 255 characters. 

For more information and formula examples, please see: Excel Vlookup and Match 

Excel Hlookup and Match 

 

OFFSET MATCH 

A more complex but a more powerful lookup formula, free of many limitations of Vlookup and 

Hlookup. 

 

Formula for VLookup 

 

 

 

Where: 

n - is the lookup column offset, i. e. the number of columns to move from the starting point to the 

lookup column. 

m - is the return column offset, i. e. the number of columns to move from the starting point to the 

return column. 

 

Formula for HLookup 

 

 

 

Where: 

n - is the lookup row offset, i. e. the number of rows to move from the starting point to the lookup 

row. 

m - is the return row offset, i. e. the number of rows to move from the starting point to the return 

row. 

OFFSET(lookup_table, MATCH(lookup_value, 

OFFSET(lookup_table, 0, n, ROWS(lookup_table), 1) ,0) -1, 

m, 1, 1) 

OFFSET(lookup_table, m, MATCH(lookup_value, 

OFFSET(lookup_table, n, 0, 1, COLUMNS(lookup_table)), 0) - 

1, 1, 1) 



 

Formula for matrix lookup (by row and column) 

 

Please pay attention that this is an array formula, which is entered by pressing Ctrl + Shift + Enter 

keys at the same time. 

Pros: Allows performing a left-side Vlookup, an upper Hlookup and two- way lookup (by 

column and row values), unaffected by changes in the data set. 

Cons: Complex and difficult to remember syntax. 

For more information and formula examples, please see: Using OFFSET function in Excel 

 

INDEX MATCH 

It's the best way to do vertical or horizontal lookup in Excel that can replace most of the above 

formulas. The Index Match formula is my personal preference and I use it for almost all of my 

Excel lookups. 

 

Formula for V-Lookup 

 

 

 

Formula for H-Lookup 

 

 

 

Formula for matrix lookup 

An extension of the classic Index Match formula to return a value at the intersection of a specific 

column and row: 

INDEX (lookup_table, MATCH (vertical_lookup_value, lookup_column, 0), MATCH 

(horizontal_lookup_value, lookup_row, 0)) 

Cons: Just one - you need to remember the formula's syntax. Pros: The most versatile Lookup 

{=OFFSET (starting_point, MATCH (vertical_lookup_value, 

lookup_column, 0), MATCH (horizontal_lookup_value, lookup_row, 0))} 

INDEX (return_column, MATCH (lookup_value, 

lookup_column, 0)) 

INDEX (return_row, MATCH (lookup_value, lookup_row, 

0)) 



formula in Excel, superior to Vlookup, Hlookup and Lookup functions in many respects: 

 

It can do left and upper lookups. 

Allows safely extending or collapsing the lookup table by inserting or deleting columns and rows. 

No limit to the lookup value's size. 

Works faster. Because an Index Match formula references columns/rows rather than an entire 

table, it requires less processing power and won't slow down your Excel. 

For more information, please check out: 

INDEX MATCH as a better alternative to VLOOKUP 

INDEX MATCH MATCH formula for two-dimensional lookup 

 

Excel Lookup comparison table 

As you see, not all Excel Lookup formulas are equivalent, some can handle a number of different 

lookups while others can only be used in a specific situation. The table below outlines the 

capabilities of each Lookup formula in Excel. 



Excel Settings in the Registry: 

The Windows Registry is essentially a central hierarchical database that is used by the operating 

system and by application software. The Registry first appeared in Windows 95 and replaces the 

old INI files that stored Windows and application settings. 

You can use the Registry Editor program to browse the Registry - and even edit its contents if 

you know what you're doing. The Registry Editor is named regedit.exe . Before beginning your 

explorations, take a minute to read the upcoming sidebar (titled "Before You Edit the Registry "). 

Figure 4-9 shows what the Registry Editor looks like. 

The Registry Editor lets you browse and make changes to the Registry. 

The Registry consists of keys and values, arranged in a hierarchy. The top-level keys are: 

o HKEY_CLASSES_ROOT 

o HKEY_CURRENT_USER 

o HKEY_LOCAL_MACHINE 

o HKEY_USERS 

o HKEY_CURRENT_CONFIG 

o HKEY_DYN_DATA 

Excel's settings: 

Information used by Excel 2007 is stored in this Registry section: 

HKEY_CURRENT_USER\Software\Microsoft\Office.0\Excel 

 
 

Before You Edit the Registry: 

You can use the regedit.exe program to change anything in the Registry, including information 

that is critical to your system's operation. In other words, if you change the wrong piece of 

information, Windows may no longer work properly. 

Get into the habit of choosing the File  Export command in Regedit. This command enables 

you to save an ASCII version of the entire Registry or just a specific branch of the Registry. 

If you find that you messed up something, you can always import the ASCII file to restore the 

Registry to its previous condition (choose the Registry  Import Registry File command). 

Refer to the Help file for Regedit for details. In this section of the Registry, you'll find a number 

of keys that contain specific values that determine how Excel operates. 

The Registry settings are updated automatically by Excel when Excel closes. 

Note: It's important to understand that Excel reads the Windows Registry only once - when it 

starts up. In addition, Excel updates the Registry settings only when Excel closes normally. 

If Excel crashes ( unfortunately , not an uncommon occurrence), the Registry information 

is not updated. For example, if you change one of Excel's settings, such as the visibility of 

the Formula bar, this setting is not written to the Registry until Excel closes by normal 

means. 

 



Table1 lists the Registry sections that are relevant to Excel 2007. You might not find all these 

sections in your Registry database. 

Table1: EXCEL CONFIGURATION INFORMATION IN THE REGISTRY 

 

Although you can change most of the settings via the Excel Options dialog box, a few settings 

cannot be changed directly from Excel (but you can use the Registry Editor to make changes). 

For example, when you select a range of cells, you may prefer that the selected cells appear in 

high contrast white-on-black. There is no way to specify this in Excel, but you can add a new 

Registry key like this: 

1. Open the Registry Editor and locate this section: 

 HKEY_CURRENT_USER\Software\Microsoft\Office.0\Excel\Options  

2. Right-click and select New  DWORD Value. 

3. Name this value Options6 . 

4. Right-click the Options6 key and select Modify. 

5. In the Edit DWORD Value dialog box, click the Decimal option and enter 16  

 Setting a value for a Registry setting. 

When you restart Excel, range selections will appear with a black background rather than gray. If 

you don't like this look, just delete the Options6 Registry entry. 

Tip   If you have trouble starting Excel, it's possible that the Registry keys have become corrupt. 

You can try using the Registry Editor to delete the entire Excel section: 

  HKEY_CURRENT_USER\Software\Microsoft\Office.0\Excel   

The next time Excel is started, it will rebuild the Registry keys. You will, however, lose all of the 

customization information that was stored there. 

 



Advanced Excel tips and tricks 

Advanced Excel tips and tricks can greatly enhance your productivity and efficiency when 

working with complex spreadsheets and large datasets. By mastering techniques such as keyboard 

shortcuts, conditional formatting, data validation, PivotTables, VLOOKUP and INDEX-MATCH 

functions, Excel tables, named ranges, Power Query, macros, and array formulas, you can 

streamline your workflow, automate tasks, perform sophisticated data analysis, and save valuable 

time. These advanced features empower you to work more efficiently, make informed decisions, 

and unlock the full potential of Excel for your data-driven tasks. 

 

 

• Advanced Excel Tips and Tricks for Productivity and Efficiency 

o Master Keyboard Shortcuts. 

o Conditional Formatting. 

o Data Validation. 

o PivotTables. 

o VLOOKUP and INDEX-MATCH Functions. 

o Excel Tables. 

o Named Ranges. 

o Power Query. 

o Macros. 

o Array Formulas. 

 

Advanced Excel Tips and Tricks for Productivity and Efficiency 

Master Keyboard Shortcuts: 

Learn commonly used keyboard shortcuts to perform tasks more efficiently. Some 

essential shortcuts include: 

 

o Ctrl+C for copy, Ctrl+V for paste, Ctrl+Z for undo, and Ctrl+S for save. 

o Ctrl+X for cut, Ctrl+B for bold, Ctrl+I for italic, and Ctrl+U for underline. 

o Ctrl+Home to go to the beginning of the worksheet and Ctrl+End to go to the last cell 

with data. 

o Ctrl+Page Up to switch between worksheets and Ctrl+Tab to cycle through open 

workbooks. 

 

Conditional Formatting: 

Utilize conditional formatting to visually highlight and format cells based on specific 

conditions or criteria. This feature helps you identify patterns, outliers, or important data at a 

glance. Some advanced techniques include: 

o Color scales to represent data ranges using different colors. 

o Icon sets to display symbols or icons based on data values. 

o Data bars to create horizontal bars proportional to the cell values. 



o Formulas to create custom formatting rules based on specific criteria. 

 

 

Data Validation: 

Apply data validation to control and validate the type and range of data entered into cells. This 

ensures data accuracy and consistency. Some advanced techniques include: 

o Drop-down lists to provide predefined choices for data input. 

o Custom formulas to create complex validation rules based on specific conditions. 

o Input messages to provide instructions or guidance to users when entering data. 

o Error alerts to display custom error messages when invalid data is entered. 

 

PivotTables: 

Become proficient in creating and using PivotTables to analyze and summarize large 

datasets. PivotTables allow you to: 

o Summarize data by grouping and aggregating values based on different criteria. 

o Add calculated fields to perform custom calculations within the PivotTable. 

o Use slicers to filter data and easily analyze subsets of information. 

o Create Pivot Charts to visualize and explore data interactively. 

o Refresh data automatically when the source data changes. 

 

VLOOKUP and INDEX-MATCH Functions: 

Master the use of VLOOKUP and INDEX-MATCH functions for advanced data retrieval 

and analysis. These functions allow you to search for a value in one column and return a 

corresponding value from another column. Some tips for using these functions effectively are: 

o Use the INDEX-MATCH combination when the lookup value is not in the leftmost 

column of the table. 

o Combine multiple criteria by nesting INDEX-MATCH functions. 

o Utilize approximate match for finding values within a range. 

 

Excel Tables: 

Convert your data range into an Excel table to leverage advanced features and enhance data 

management. Excel tables provide: 

o Dynamic range references that automatically expand when new data is added. 

o Automatic formatting and styles to make your data visually appealing. 

o Easy sorting and filtering options for quick data analysis. 

o Structured referencing in formulas for better readability and maintainability. 

o Total rows that automatically calculate sums or other aggregations for each column. 

 



Named Ranges: 

Assign names to cell ranges to make formulas more readable and easier to manage. By 

using named ranges, you can: 

o Replace complex cell references with meaningful names in formulas. 

o Improve formula transparency and reduce the risk of errors. 

o Create more flexible and adaptable formulas that can refer to named ranges across 

worksheets or workbooks. 

o Easily update formulas by modifying the named range instead of manually adjusting cell 

references. 

 

Power Query: 

Power Query is a powerful data transformation and cleaning tool available in newer versions of 

Excel. It allows you to: 

o Import and combine data from various sources, such as databases, CSV files, or websites. 

o Perform data cleaning operations, such as removing duplicates, filtering rows, or splitting 

columns. 

o Merge or append multiple datasets into a single table. 

o Apply transformations and calculations to shape the data before loading it into Excel. 

o Establish a connection to external data sources 

for automatic data refresh. 

 

Macros: 

Use macros to automate repetitive tasks in Excel. Macros are recorded sequences of actions that 

can be played back with a single click or assigned to a keyboard shortcut. With macros, you can: 

o Automate formatting tasks, such as applying specific styles, adjusting column widths, or 

adding headers and footers. 

o Perform data manipulations, such as sorting, filtering, or removing blank rows. 

o Create custom functions or calculations that are 

o not available in built-in Excel functions. 

o Generate reports or charts automatically based on predefined templates. 

o Combine multiple actions into a single macro to streamline complex tasks. 

 

Array Formulas: 

Array formulas allow you to perform calculations on multiple cells simultaneously. By 

using array formulas, you can: 

o Perform complex calculations, such as array multiplication, matrix operations, or 

advanced statistical calculations. 

o Manipulate multiple cells within a single formula, eliminating the need for intermediate 

columns or helper calculations. 



o Apply conditional logic or perform calculations across multiple dimensions. 

o Remember to enter array formulas by pressing Ctrl+Shift+Enter instead of just pressing 

Enter. 

 

By incorporating these advanced Excel tips and tricks into your workflow, you can 

significantly increase your productivity and efficiency when working with complex data 

and tasks. These techniques enable you to streamline processes, automate repetitive tasks, 

and extract valuable insights from your data more effectively. 

  



What is a Pivot Table: 

A Pivot Table is a tool in Microsoft Excel that allows you to quickly summarize huge datasets 

(with a few clicks). 

Even if you’re absolutely new to the world of Excel, you can easily use a Pivot Table. It’s as 

easy as dragging and dropping rows/columns headers to create reports. 

Inserting a Pivot Table in Excel: 

Here are the steps to create a pivot table using the data shown above: 

● Click anywhere in the dataset. 

● Go to Insert –> Tables –> Pivot Table. 

● In the Create Pivot Table dialog box, the default options work fine in most of the cases. 

Here are a couple of things to check in it: 

● Table/Range: It’s filled in by default based on your data set. If your data has no 

blank rows/columns, Excel would automatically identify the correct range. You can 

manually change this if needed. 

● If you want to create the Pivot Table in a specific location, under the option ‘Choose 

where you want the PivotTable report to be placed’, specify the Location. Else, a 

new worksheet is created with the Pivot Table.

 

● Click OK. 



As soon as you click OK, a new worksheet is created with the Pivot Table in it. 

While the Pivot Table has been created, you’d see no data in it. All you’d see is the Pivot Table 

name and a single line instruction on the left, and Pivot Table Fields on the right. 

 

Now before we jump into analyzing data using this Pivot Table, let’s understand what are the 

nuts and bolts that make an Excel Pivot Table. 

Analyzing Data Using the Pivot Table: 

Now, let’s try and answer the questions by using the Pivot 

To analyze data using a Pivot Table, you need to decide how you want the data summary to look 

in the final result. For example, you may want all the regions in the left and the total sales right 

next to it.  You have this clarity in mind, you can simply drag and drop the relevant fields in the 

Pivot Table. 

In the Pivot Table Fields section, you have the fields and the areas (as highlighted below): 

https://trumpexcel.com/show-pivot-table-fields/


The Fields are created based on the backend data used for the Pivot Table. The Areas section is 

where you place the fields, and according to where a field goes, your data is updated in the Pivot 

Table. 

It’s a simple drag and drop mechanism, where you can simply drag a field and put it in one of the 

four areas. As soon as you do this, it will appear in the Pivot Table in the worksheet. 

Note that by default, the items (in this case the customers) are sorted in an alphabetical order. 

What is pivot chart ? 

Pivot Chart is a dynamic visualization tool that works together with Excel PivotTables. While 

PivotTables provide a way to summarize and analyze large datasets, Pivot Charts offer a 

graphical representation of that summarized data, making trends and patterns easier to spot. 

 

 

https://www.ablebits.com/office-addins-blog/excel-pivot-table-tutorial/


How to make a pivot chart in Excel: 

Before you start creating a pivot chart, it's important to make sure your data is well-organized 

and structured. Each column should represent a different variable or category, and each row 

should contain a unique record. Don't forget to remove any blank rows or columns and double-

check your data for errors or inconsistencies. 

Tip. If you want your graph to automatically include new records, then format your source data 

as a table. 

Step 1. Insert a pivot chart 

1. Select any cell in your dataset. 

2. On the Insert tab, in the Charts group, click PivotChart. 

 

 

https://www.ablebits.com/office-addins-blog/excel-table-tutorial/


3. The Create PivotChart dialog window will pop up, automatically selecting the entire data 

range or table. It will then prompt you to choose where to insert your visual - either in a new 

worksheet or an existing one. Select your preferred location and click OK. 

Note. Inserting a pivot chart will automatically include a pivot table alongside it, as these two 

things are closely related. 

Step 2. Configure pivot chart 

Now that you have a blank pivot table and pivot chart ready, it's time to set them up to display 

your data trends. In the PivotChart pane that appears on the left, you'll find a list of all the fields 

from your dataset. Select the fields you want to display in the graph, and then drag and drop 

them into the corresponding areas. 

• Filters - add filters to display or hide certain data. 

• Axis (Categories) – define what data categories to display along the horizontal axis (placed in 

pivot table rows). 

• Legend (Series) – indicate what data series to display (placed in pivot table columns). 

• Values – define the values that will be depicted in the chart. 



For example, to visualize the total revenue for different project types and statuses, you could 

drag the "Status" field to the Legend area, "Project type" to the Axis area, and "Total revenue" to 

the Values area. 

How to create a chart from a pivot table 

If you already have a pivot table set up, here's how you can easily create a graph from it: 

1. Select any cell within your PivotTable. 



2. Navigate to the Insert tab on the Excel ribbon and click on the PivotChart button.

 

3. In the dialog box that appears, choose the type of graph you want to create. Here are some 

recommendations: 

o Bar charts are ideal for comparing values across different categories or time periods. 

o Line charts work well for illustrating trends over time or continuous data series. 

o Pie charts are effective for showing the proportion of each category in a dataset. 

o Scatter plots are useful for visualizing the relationship between two variables and 

identifying any correlations or patterns. 

4. Once you've selected your desired type, click OK. 

 

 

 

 

 

https://www.ablebits.com/office-addins-blog/make-bar-graph-excel/
https://www.ablebits.com/office-addins-blog/make-line-graph-excel/
https://www.ablebits.com/office-addins-blog/make-pie-chart-excel/
https://www.ablebits.com/office-addins-blog/make-scatter-plot-excel/


5. You will find the visual in the same worksheet next to your PivotTable. You can move it to 

a different location by dragging and change its size using the resize handles, just as you 

would with any Other graph in Excel.

 

Pivot chart shortcut key 

To swiftly make a graph based on a pivot table, you can use the following keyboard shortcuts: 

1. Select any cell within the pivot table. 

2. Press the F11 key to create a graph in a new Chart sheet. 

3. Alternatively, use the Alt + F1 shortcut to insert a chart on the active sheet. 

The newly created pivot chart will automatically use the default type. From there, you can easily 

modify it to suit your preferences by selecting a different chart type. 

How to modify a pivot chart 

Pivot charts are not just powerful visualization tools; they're also incredibly flexible, allowing 

you to tweak nearly every aspect to suit your needs. 

To show, hide or format graph elements like axes, labels, and legend, simply click the Chart 

Elements button (a plus sign) at the upper right.  

 

 

 

 

https://www.ablebits.com/office-addins-blog/pivot-charts-excel/#modify


Corner of the graph: 

From For changing the chart style, click the Style icon at the upper right corner and choose 

various predefined styles: 

 

 

For more options to adjust colours and styles, explore the Design and Format tabs on the ribbon. 

These tabs offer additional settings and tools to fine-tune your pivot chart to perfection. 



How to change pivot chart type 

You can change the type of your pivot graph at any time after you make it. Here are the steps: 

1. Click anywhere within your graph to activate the pivot chats tabs on the ribbon. 

2. On the Design tab, in the Type group, click Change Chart Type. 

3. Select the desired chart type from the options provided, and then click OK. 

With these simple steps, you can quickly change the appearance of your pivot graph to better suit 

your data visualization goals. 

 

 

 



Conditional Formatting 

Use conditional formatting in Excel to automatically highlight cells based on their content. 

Simply apply a rule or use a formula to determine which cells to format. 

Highlight Cells Rules 

To highlight cells that are greater than a value, execute the following steps. 

1. Select the range A1:A10. 

 

2. On the Home tab, in the Styles group, click Conditional Formatting. 

 

3. Click Highlight Cells Rules, Greater Than. 

 

4. Enter the value 80 and select a formatting style. 



 

5. Click OK. 

Result. Excel highlights the cells that are greater than 80. 

 

6. Change the value of cell A1 to 81. 

Result. Excel changes the format of cell A1 automatically. 

 

Note: you can also use this category (see step 3) to highlight cells that are less than a value, 

between two values, equal to a value, cells that contain specific text, dates (today, last week, next 

month, etc.), duplicates or unique values. 

Clear Rules: 

To clear a conditional formatting rule, execute the following steps. 

1. Select the range A1:A10. 

https://www.excel-easy.com/examples/find-duplicates.html


 

2. On the Home tab, in the Styles group, click Conditional Formatting. 

 

3.Click Clear Rules, Clear Rules from Selected Cells. 

 

Top/Bottom Rules 

To highlight cells that are above average, execute the following steps. 

1. Select the range A1:A10. 



 

2. On the Home tab, in the Styles group, click Conditional Formatting. 

 
3. Click Top/Bottom Rules, Above Average. 

 
 

4. Select a formatting style. 

5.   

5. Click OK. 



Result. Excel calculates the average (42.5) and formats the cells that are above this average. 

 

Note: you can also use this category (see step 3) to highlight the top n items, the top n percent, 

the bottom n items, the bottom n percent or cells that are below average. 

  



ADVANCE CHART & GRAPH: 

The excel charts and graphs are the tools used to visualise the data by representing their values. 

Now, let’s discuss the advanced charts and its usage in excel. 

What is an advanced chart in Excel ? 

Advanced charts are the charts that are beyond the basic charts in excel. If the user has more than 

one set of data and if the user wants to compare the data values on the same chart, then the 

advanced charts come in handy. The user can create the basic chart for one set of data and then 

they can add more datasets to that chart. The user can also format the charts, etc. 

The importance of advanced charts in Excel 

1. Advanced charts provide more consolidated information in a single chart. It paves way for the 

user to compare more than one data set and it helps alot to draw decisions. 

2. Advanced charts allow the user to customize the way it appears. 

How to Create an Advance Chart in Excel: 

In this example, we will create a column chart and format its various chart elements. We 

will use random sales data for different courses for this. 

 

Step 1: Create a Dataset in a workbook 

In this step, we will be creating the dataset using the following random sales data for 

different courses. 

 

Fig 1 – Dataset 

Step 2: Insert Chart 

Now, we will be inserting the chart for our dataset. To do this, we need to Select Data and 

then navigate to Insert. Then click on Charts and then select Column Chart there. 



 

Fig 2 – Insert Chart 

By doing this, Excel will automatically insert a column chart for our dataset. 

 

Fig 3 – Column Chart 

The Format Pane is introduced in Excel 2013 which provides a chart formatting option for 

various chart elements. To access the formatting pane, we need to Select Chart Element > 

Right-Click > Format<chart_element> Excel will open a Format Pane for that particular 

chart element on the right side of the spreadsheet. 

Step 3: Format Axis 

In this step, we will format the chart axis. First, Select Axis, then Right-Click on it, and 

then select Format Axis. 

 

 

 



 

Fig 4 – Format Axis 

Once we click on the Format Axis option, Excel will automatically open a Format 

Axis Pane. 

 

Fig 5 – Format Axis 

Using the format axis pane, we can format our chart axis according to our requirements. 

Here, we are going to change units to display in Hundreds and Tick Mark as Inside for 

Minor Type. 



 

Fig 6 – Format Axis 

Similarly, we will also change the Tick Marks for Minor Type to Inside for Horizontal-

Axis and we will get the following output. 

 

Fig 7 – Formatted Axis Output 

Step 4: Format Chart Area 

In this step, we will format the Chart Area. To make the chart look more enhanced and 

cleaner. For this Select Chart Area and then Right Click on it and select Format Chart 

Area. Please, make sure to click on Chart Area, not the Plot Area. 



 

Fig 8 – Chart Area & Plot Area 

Once we select the chart area and perform the above operation, excel will open the Format 

Chart Area pane. 

 

Fig 9 – Format Char Area Options 

To format the chart area pane, we are adding gradient colour to our chart. Go to Format 

Chart Area, click on Fill & Line, and select Gradient Fill. 



 

Fig 10 – Gradient Fill 

Once we choose the Gradient fill option, excel will automatically fill the gradient colour to 

our Chart Area. Similarly, we will also add the Gradient Fill to our Plot Area, and we will 

get the following output. 

 

Fig 11 – Formatted Chart & Plot Area Output 

Step 5: Format Chart Title 

In this step, we will format the Chart Title.  

To make the chart look more enhanced and cleaner. For this Select Chart Title and then Right 

Click on it and select Format Chart Title. This will open the Format Chart Title pane on 

the right side of the spreadsheet.  

Using Format Chart Title, we are choosing the Gradient Fill option to fill gradient colour to 

our chart title. Also, we will change the title to Sales Chart. After adding these changes, we 

will get the following output. 



 

Fig 13 – Formatted Chart Title 

Step 6: Format Data Series 

In this step, we will format the Chart Data Series. To make the chart look more 

enhanced and cleaner. For this Select Chart Data Series and then Right Click on it 

and select Format Data Series. 

 

Fig 14 – Format Data Series 

This will open the Format Data Series pane on the right side of the Excel spreadsheet. 

Using the Format Data Series, we will add a 3-D effect to our data series. 

 

Fig 15 – Format Data Series 



Once we add the 3-D effect to our data series we will get the following final output. 

 

Fig 16 – Output 

FAQs on Chart Formatting? 
 

What is the need of formatting a chart? 

Formatting the chart makes the chart easier to read and also qualifies you to explain the data in 

detail. 

What are the best-advanced Graphs in Excel?  

• Sankey diagram 

• Likert Scale chart 

• Comparison Bar Chart 

• Gauge Chart 

• Multi-Axis Line Chart 

• Sunburst Chart 

• Radar Chart 

• Radial Bar Chart 

• Box and Whisker Chart 

• Dot Plot Chart 

 

 

 

  



What is Power Query? 

Power Query is a business intelligence tool available in Excel that allows you to import data from 

many different sources and then clean, transform and reshape your data as needed. 

 

It allows you to set up a query once and then reuse it with a simple refresh. It’s also pretty 

powerful. Power Query can import and clean millions of rows into the data model for analysis 

after. The user interface is intuitive and well laid out so it’s really easy to pick up. It’s an 

incredibly short learning curve when compared to other Excel tools like formulas or VBA. 

 

The best part about it, is you don’t need to learn or use any code to do any of it. The power query 

editor records all your transformations step by step and converts them into the M code for you, 

similar to how the Macro recorder with VBA. 

 

If you want to edit or write your own M code, you certainly can, but you definitely don’t need to. 

 

 

What Can Power Query Do? 

 

Imagine you get a sales report in a text file from your system 

 

on a monthly basis that looks like this. 

 

Every month you need to go to the folder where the file is uploaded and open the file and copy the 

contents into Excel. You then use the text to column feature to split out the data into new 

columns. 

The system only outputs the sales person’s ID, so you need to add a new column to the data and 

use a VLOOKUP to get the salesperson associated with each ID. Then you need to summarize the 

sales by salesperson and calculate the commission to pay out. 



 

You also need to link the product ID to the product category but only the first 4 digits of the 

product code relate to the product category. You create another column using the LEFT function 

to get the first 4 digits of the product code, then use a VLOOKUP on this to get the product 

category. Now you can summarize the data by category. 

 

Maybe it only takes an hour a month to do, but it’s pretty mindless work that’s not enjoyable and 

takes away from time you can actually spend analyzing the data and producing meaningful 

insight. 

With Power Query, this can all be automated down to a click of the refresh button on a monthly 

basis. All you need to do is build the query once and reuse it, saving an hour of work each and 

every month! 

 

Where is Power Query? 

Power Query is available as an add-in to download and install for Excel 2010 and 2013 and will 

appear as a new tab in the ribbon labelled Power Query. In 2016 it was renamed to Get & 

Transform and appears in the Data tab without the need to 

install any add-in. 

 

Importing Your Data with Power Query 

 



 

Importing your data with Power Query is simple. Excel provides many common data connections 

that are accessible from the Data tab and can be found from the Get Data command. 

• Get data from a single file such as an Excel workbook, Text or CSV file, XML and JSON 

files. You can also import multiple files from within a given folder. 

• Get data from various databases such as SQL Server, Microsoft Access, Analysis 

Services, SQL Server Analysis Server, Oracle, IBM DB2, MySQL, PostgreSQL, Sybase, 

Teradata and SAP HANA databases. 

• Get data from Microsoft Azure 

• Get data from online services like Sharepoint, Microsoft Exchange, Dynamics 365, 

Facebook and Salesforce. 

• Get data from other sources like a table or range inside the current workbook, from the 

web, a Microsoft Query, Hadoop, OData feed, ODBC and OLEDB. 

• We can merge two queries together similar to joining two queries in SQL. 

• We can append a query to another query similar to a union of two queries in SQL. 

 

Note: The available data connection options will depend on your version of Excel. 

 

There are a couple of the more common query types available in the top level of the ribbon 

commands found in the Get & Transform section of the Data tab. From here we can easily 

access the From Text/CSV, From Web and From Table/Range queries. These are just 

duplicated outside of the Get Data command for convenience of use, since you’ll likely be using 

these more frequently. 

Depending on which type of data connection you choose, Excel will guide you through the 

connection set up and there might be several options to select during the process. 



At the end of the setup process, you will come to the data preview window. You can view a 

preview of the data here to make sure it’s what you’re expecting. You can then load the data as 

is by pressing the Load button, or you can proceed to the query editor to apply any data 

transformation steps by pressing the Edit button. 

 

A Simple Example of Importing Data in an Excel File 

Let’s take a look at importing some data from an Excel workbook in action. We’re going to 

import an Excel file called Office Supply Sales Data.xlsx. It contains sales data on one sheet 

called Sales Data and customer data on another sheet called Customer Data. Both sheets of data 

start in cell A1 and the first row of the data contains column headers. 

 

Go to the Data tab and select the Get Data command in the Get & Transform Data section. 

Then go to From File and choose From Workbook. 

This will open a file picker menu where you can navigate to the file you want to import. Select 

the file and press the Import button. 

 



After selecting the file you want to import, the data preview Navigator window will open. This 

will give you a list of all the objects available to import from the workbook. Check the box to 

Select multiple items since we will be importing data from two different sheets. Now we can 

check both the Customer Data and Sales Data. 

When you click on either of the objects in the workbook, you can see a preview of the data for it 

on the right hand side of the navigator window. This is great for a sense check to make sure 

you’ve got the correct file. 

When you’re satisfied that you’ve got everything you need from the workbook, you can either 

press the Edit or Load buttons. The edit button will take you to the query editor where you can 

transform your data before loading it. Pressing the load button will load the data into tables in 

new sheets in the workbook. 

In this simple example, we will bypass the editor and go straight to loading the data into Excel. 

Press the small arrow next to the Load button to access the Load To options. This will give you a 

few more loading options. 



 

 

We will choose to load the data into a table in a new sheet, but there are several other options. 

You can also load the data directly into a pivot table or pivot chart, or you can avoid loading the 

data and just create a connection to the data. 

 

 

Now the tables are loaded into new sheets in Excel and we also have two queries which can 



quickly be refreshed if the data in the original workbook is ever updated. 

 

The Query Editor 

 

After going through the guide to connecting your data and selecting the Edit option, you will be 

presented with the query editor. This is where any data transformation steps will be created or 

edited. There are 6 main area in the editor to become familiar with. 

1. The Ribbon – The user interface for the editor is quite similar to Excel and uses a visual 

ribbon style command center. It organizes data transformation commands and other power 

query options into 5 main tabs. 

2. Query List – This area lists all the queries in the current workbook. You can navigate to 

any query from this area to begin editing it. 

3. Data Preview – This area is where you will see a preview of the data with all the 

transformation steps currently applied. You can also access a lot of the transformation 

commands here either from the filter icons in the column headings or with a right click on 

the column heading. 

The Query List: 

1. Formula Bar – This is where you can see and edit the M code of the current 

transformation step. Each transformation you make on your data is recorded and appears 

as a step in the applied steps area. 

2. Properties – This is where you can name your query.  When you close and load the query 

to an Excel table, power query will create a table with the same name as its source query if 

the table name isn’t already taken. The query name is also how the M code will reference 

this query if we need to query it in another query. 

3. Applied Steps – This area is a chronological list of all the transformation steps that have 

been applied to the data. 



One of the primary functions of the query list is navigation. There’s no need to exit the query 

editor to switch which query you’re working on. You can left click on any query to switch. The 

query you’re currently on will be highlighted in a light green colour. 

When you do eventually exit the editor with the close 

and load button, changes in all the queries You can 

hide the query list to create more room for the data 

preview. Left click on the small arrow in the upper 

right corner to toggle the list between hidden and 

visible. 

 

 

 

 

 

 

 

 

 

 

 

 

If you right click on any query in the list, there are a variety of options available. 

• Copy and Paste – Copy and paste a query to make another copy of it. 

• Delete – Delete the query. If you accidentally delete a query, there’s no undo button, but you 

can exit the query editor without saving via close and load to restore your query. 

• Rename – Rename your query. This is the same as renaming it from the properties section 

on the left hand side of the editor. 

• Duplicate – Make another copy of the query. This is the same as copy and paste but turns 

the process into one step. 

• Move To Group – Place your queries into a folder like structure to keep them organised 

when the list gets large. 

• Move Up and Move Down – Rearrange the order your queries appear in the list or within 

the folder groups to add to your organisational efforts. This can also be done by dragging 

and dropping the query to a new location. 

• Create Function – Turn your query into a query function. They allow you to pass a 

parameter to the query and return results based on the parameter passed. 

• Convert To Parameter – Allows you to convert parameters to queries or queries to 

parameters. 

• Advanced Editor – Open the advanced editor to edit the M code for the query. 



• Properties – Allows you to change the query name, add a description text and enable Fast 

Data Load option for the query. 

 

If you right click any empty area in the query list, you can create a new query. 

 

The Data Preview 

The main job of the data preview area is to apply transformation steps to your data and show a 

preview of these steps you’re applying 

 



In the data preview area, you can select columns with a few different methods. A column will be 

highlighted in a light green colour when it’s selected. 

• Select a single column with a left click on the column 

heading. 

• Select multiple adjacent columns with a left click on the 

first column heading, then hold Shift and left click on the 

last column heading. 

• Select multiple non-adjacent columns by holding Ctrl then 

left click on any column headings you want to select. 

 

You can then apply any relevant data transformation steps on 

selected columns from the ribbon or certain steps can be 

accessed with a right click on the column heading. Commands 

that are not available to your selected column or Each column 

has a data type icon on the left hand of the column heading. 

You can left click on it to change the data type of the column. 

You can choose from decimal numbers, currency, whole numbers, percentages, date and time, 

dates, times, timezone, duration, text, Boolean, and binary. 

Using the Locale option allows you to set the data type format using the convention from 

different locations. For example, if you wanted to display the date in the American m/d/yyyy 

format instead of the usual dd/mm/yyyy then you could select United States as the locale. 



 

There’s a small table icon in the top left hand corner of the data preview, 

you can right click or left click this to access various actions that affect the 

whole table. 

 

 

 

Renaming any column heading is really easy. 

 

Double left click on any column heading then type your new name and press Enter when you’re 

done. 

You can change around the order of any of the columns 

with a left click and drag action. The green border 

between two columns will become the new location of 

the dragged column when you release the left click. 

 

 

Each column also has a filter toggle on right hand side. 

Left click on this to sort and filter your data. This filter 

menu is very similar to the filters found in a regular 

spreadsheet and will work the same way. 



The list of items shown is based on a sample of the data so 

may not contain all available items in the data. You can load 

more by clicking on the Load more text in blue. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Many transformations found in the ribbon menu are also accessible from the data preview area 

using a right click on the column heading. Some of the action you select from this right click 

menu will replace the current column. If you want to create a new column based, use a command 

from the Add Column tab instead. 

 

 

The Applied Steps 

 

Any transformation you make to your data will appear as a step in the Applied Steps area. It also 

allows you to navigate through your query. Left click on any step and the data preview will 

update to show all transformations up to and including that step. 

 

 



You can insert new steps into the query at any point by selecting the previous step and then 

creating the transformation in the data preview. Power Query will then ask if you want to insert 

this new step. Careful though, as this may break the following steps that refer to something you 

changed. 

 

 

 

 

You can delete any steps that were applied using the X on the left hand side of the step name in 

the Applied Steps area. Caution is needed though, as if any of the following steps depend on the 

step you’re trying delete, you will break your query. This is where Delete Until End from the 

right click menu can be handy. 

 

 



A lot of transformation steps available in power query will have various user input parameters and 

other setting associated with them. If you apply a filter on the product column to show all items 

not starting with Pen, you might later decide you need to change this filter step to show all items 

not equal to Pen. You can make these edits from the Applied Step area. 

Some of the steps will have a small gear icon on the right hand side. This allows you to edit the 

inputs and settings of that step. 

 

You can rearrange the order the steps are performed in your query. Just left click on any step and 

drag it to a new location. A green line between steps will indicate the new location. This is 

another one you’ll need to be careful with as a lot of steps will depend on previous steps, and 

changing ordering can create errors because of this. 

 

 



 

 

Right click on any step to access a menu of options. 

 

• Edit Settings – This allows you to edit the settings of the step similar to using the gear 

icon on the right hand side of the step. 

• Rename – This allows you to rename the steps label. Instead of the displaying the 

generic name like “Filtered Rows“, you could have this display something like “Filtered 

Product Rows on Pens” so you can easily identify what the step is doing. 

• Delete – This deletes the current step similar to the X on the left hand side of the step. 

• Delete Until End – This allows you to delete the current step plus all steps up until the 

end. Since steps can depend on previous steps, deleting all steps after a step is a good 

way to avoid any errors. 

• Insert Step After – This allows you to insert a new step after the current step. 

• Move Up and Move Down – This allows you to rearrange the query steps similar to the 

dragging and dropping method. 

• Extract Previous – This can be a really useful option. It allows you to create a new copy 

of the query up to the selected step. 



The Formula Bar 

 

 

When you click on different steps of the transformation process in the Applied Steps area, the 

formula bar updates to show the M code that was created for that step. If the M code generated is 

longer than the formula bar, you can expand the formula bar using the arrow toggle on the right 

hand side. 

 

 

 

 

You can edit the M code for a step directly from the formula bar without the need to open the 

advanced editor. In this example, we’ve changed our filter from “Pen” to “Chair” by typing in 

the formula bar and then pressing Enter or using the check mark on the left to confirm the 

change. Press Esc or use the X on the 

left to discard any changes. 

 

 

The File Tab 

The File tab contains various options for saving any changes made 

to your queries as well as power query options and settings. 

• Close & Load – This will save your queries and load your 

current query into an Excel table in the workbook. 

• Close & Load To – This will open the Import Data menu 

with various data loading options to choose from. 

• Discard & Close – This will discard any changes you made to 

the queries during your session in the editor and close the 

editor. 



Data Loading Options 

 

When you use the Close & Load To option to exit the editor, this will open the Import Data 

menu. 

You can choose to load the query to a table, pivot table, pivot chart or only create a connection 

for the query. The connection only option will mean there is no data output to the workbook, but 

you can still use this query in other queries. This is a good option if the query is an intermediate 

step in a data transformation process. 

You’ll also be able to select the location to load to in your workbook if you selected either a table, 

pivot table or pivot chart in the previous section. You can choose a cell in an existing worksheet 

or load it to a new sheet that Excel will create for you automatically. 

 

 

The other option you get is the Add this data to the Data Model. This will allow you to use the 

data output in Power Pivot and use other Data Model functionality like building relationships 

between tables. The Data Model Excel’s new efficient way of storing and using large amounts of 

data. 

 

The Queries & Connections Window 

When you’re working outside of the power query editor, you can see and interact with all the 

queries in the workbook through the Queries & Connections window. To open this, go to the 

Data tab in the regular Excel ribbon, then press the Queries & Connections command button 

found in the Queries & Connections section. 

When opened it will be docked to the right hand side of the workbook. You can undock it by left 

clicking on the title and dragging it. You can drag it to the left hand side and dock it there or leave 

it floating. You can also resize the window by left clicking and dragging the edges. 



This is very similar to the query list in the editor and you can perform a lot of the same actions 

with a right click on any query. 

One option worth noting that’s not in the query list right click menu, is the Load To option. This 

will allow you to change the loading option for any query, so you can change any Connection 

only queries to load to an Excel table in the workbook. 

 

 



Another thing worth noting is when you hover over a query with the mouse cursor, Excel will 

generate a Peek Data Preview. This will show you some basic information about the query. 

• Data Preview – This is a live preview of the data similar to when first setting up a query. 

• Columns – This will give you a list of all the columns contained in the final results of the 

query along with a count of how many columns there are. Clicking on any of them will 

highlight the column in the data preview. 

• Last Refreshed – This will tell you when the data was last refreshed. 

• Load Status – This displays whether the data is loaded to a table, pivot table, pivot chart 

or is a connection only. 

• Data Sources – This will show you the source of the data along with a count of the 

number of files if you’re it’s a from folder query. 

• View in Worksheet – Clicking on this will take you to the output table if the query is 

loaded to a table, pivot table or pivot chart. 

 

You can also access this Peek view by right clicking on the query and selecting Show the peek. 

 

There are also some useful messages displayed in the Queries & 

Connections window for each query. It will show you if the 

query is a connection only, if there were any errors when the 

query last ran, or how many rows loaded. 

 

 

 

 

 

 

The Home Tab 

 

 



The Home tab contains all the actions, transformations, and settings that will affect the whole 

table. 

1. Close – You can access the Close & Load and Close & Load To options from here. 

These are also available in the File tab menu. 

2. Query – You can refresh the data preview for the current query or all query connections. 

You can also open the properties settings and the advanced editor for the current query 

and there are options under the Manage button to delete, duplicate or reference the current 

query. 

3. Manage Columns – You can navigate to specific columns and choose to keep or remove 

columns. 

4. Reduce Rows – You can manage the rows of data from this section. There are lots of 

options to either keep certain rows or remove certain rows. Keep or remove the top N 

rows, the bottom  N rows, a particular range of rows, alternating rows, duplicate rows or 

rows with errors. One option only available for removing rows is to remove blank rows. 

5. Sort – You can sort any column in either ascending or descending order. 

6. Transform – This section contains a mix of useful transformation options. 

 

• Split Columns – This allows you to split the data in a column based on a delimiter 

or character length. 

• Group By – This allows you to group and summarize your data similar to a Group 

By in SQL. 

• Data Type – This allows you to change the data type of any column. 

• Use First Row as Headers – This allows you to promote the first row of data to 

column headings or demote the column headings to a row of data. 

• Replace Values – This allows you to find and replace any value from a column. 

 

1. Combine – This sections contains all the commands for joining your query to with other 

queries. You can merge, append queries or combine files when working with a from folder 

query. 

2. Parameters – Power Query allows you to create parameters for your queries. For example 

when setting up a from folder query, you may want the folder path to be a parameter as so 

you can easily change the location. You can create and manage existing parameters from 

this section. 

3. Data Sources – This section contains the data source settings including permissions 

management for any data sources that require passwords to access. 

4. New Query – You can create new queries from new data sources or previously used data 

sources from this section. 



The Difference Between the Transform and Add Column Tabs 

 

The bulk of all transformations available in power query can be accessed through either the 

Transform tab or the Add Column tab. 

You might think there is a lot of duplication between these two  tabs. For example, both tabs 

contain a From Text section with a lot of the same commands. It’s not really the case, there 

is a subtle difference! 

When you use a command from the Add Column tab that is found in both tabs, it will create 

a new column with the transformed data and the original column will stay intact. Whereas 

using the equivalent command from the Transform tab will change the 

original column and no new column is created. 

 

The Transform Tab 

The Transform tab sections. 

1. Table – This section contains commands that will transform the entire table. You can 

group and aggregate your query, promote rows to headers, demote headers to rows 

transpose your data, reverse row order, and count rows. 

2. Any Column – This section contains commands that will work on any column of data 

regardless of data type. You can change the data type, automatically detect and 

change the data type, rename the column heading, find and replace values, fill values 

down (or up) a column to replace any blanks or nulls with the value above it (or below 

it), pivot or unpivot columns, move columns to a new location or convert a column to 

a list. 

3. Text Column – This section contains commands for text data. You can split columns 

with a delimiter, format the case, trim and clean, merge two or more columns together, 

extract text, and parse XML or JSON objects. 

4. Number Column – This section contains commands for numerical data. You can 

perform various aggregations like sums and averages, perform standard algebra 

operations or trigonometry and round numbers up or down. 

5. Date & Time Column – This section contains commands for date and time data. You 

can extract information from your dates, times and duration data. 

6. Structured Column – This section contains commands for working with nested data 

structures such as when your column contains tables. 

 

The Add Column Tab 

 



 

The Add Column tab contains a lot of commands similar to the Transform tab, but the key 

difference is they will create a new column with the transformation. 

1. General – This section allows you to add new columns based on formulas or custom 

functions. You can also add index columns or duplicate a column from here. 

2. From Text – Very similar to the From Text section in the Transform tab, but these 

commands will create a new column with the transformation. 

3. From Number – Very similar to the From Number section in the Transform tab, but 

these commands will create a new column with the transformation. 

4. From Date & Time – Very similar to the From Date & Time section in the 

Transform tab, but these commands will create a new column with the transformation. 

 

The View Tab 

 

 

 

The View tab is quite sparse in comparison to the other tabs. There are no transformation 

commands to be found in it. Most Power Query users will rarely need to use this area, but 

there are still a few things worth knowing about. 

1. Layout – This section allows you to either show or hide the Query Setting pane 

(which contain the properties and applied steps) and the Formula Bar. 

2. Data Preview – This section allows you to show or hide whitespace characters or turn 

the font into a monospace font in the data preview area. This is handy when dealing 

with data delimited by a certain number of characters. 

3. Columns – This allows you to go to and select a certain column in the data preview. 

This command is also available in the Home tab. 

4. Parameters – This allows you to enable parameterization in data sources and 

transformation steps. 

5. Advanced – This will open the advanced query editor which shows the M code for the 

query. This is also available from the Home tab. 

6. Dependencies – This will open a diagram view of the query dependencies in the 

workbook. 


